
 
 

  1

 

 

 

 

 

 

 

实 验 教 学 大 纲 汇 编 
 

市场营销专业 

（非师范专业） 

 

 

 

 

 

经济与管理学院编 

 

二○一六年六月 

 



 
 

  2

目    录 

管理信息系统实验教学大纲（对口） .................................... 1 

管理信息系统实验教学大纲（卓越） .................................... 3 

推销理论与实务实验教学大纲（对口） .................................. 5 

推销理论与实务实验教学大纲（卓越） .................................. 8 

网络营销实验课程教学大纲（对口） ................................... 11 

网络营销实验课程教学大纲（卓越） ................................... 14 

人力资源管理实验教学大纲（对口） ................................... 17 

人力资源模拟实验教学大纲（卓越） ................................... 21 

统计软件应用实验教学大纲 ........................................... 25 

生产现场管理实验课程教学大纲 ....................................... 33 

客户关系管理实验课程教学大纲 ....................................... 40 

财务报表分析实验教学大纲 ........................................... 43 

供应链管理实验教学大纲 ............................................. 46 

企业供应链模拟实验课程教学大纲 ..................................... 49 

网上开店实验课程教学大纲 ........................................... 53 

营销之道实验课程教学大纲 ........................................... 58 

推广与策划实践教学大纲 ............................................. 63 

ERP 经营沙盘模拟实验课程教学大纲 ................................... 69 

 

 

 

 

 

 

 

 

 

 



 
 

  1

管理信息系统实验教学大纲（对口） 

课程编号：12120202302             课程属性：必修 

实验学时： 18                     实验个数： 4 

学    分： 1                      开课学期： 4      

适用专业： 市场营销专业（对口）           

课程简介：  

通过该课程的学习和实验，学生应能够熟悉管理信息系统设计开发过程，制作较为详细的管理信息

系统设计报告，在此过程中认识到管理信息系统的科学性和严谨性。 

一、实验项目设置及学时分配 

项目编号 实验项目名称 
实验 

类型 

开出 

要求 

学时 

分配 

每组 

人数 

1212020230201 Access 数据库设计实验 综合 必做 4 1 

1212020230202  金蝶 KIS 账套管理 验证 必做 4 1 

1212020230203  金蝶 KIS 系统初始化 验证 必做 4 1 

1212020230204  金蝶 KIS 基本业务模块及应用 验证 必做 6 1 

学时总计 18 

二、实验内容及教学要求 

实验项目 1：数据库系统基础操作 

1、教学内容提要 

利用 Access 软件建立目标数据库 

2、教学目标要求 

掌握 ACCESS 建立企业管理系统数据库的基本技能 

熟练绘制 E-R 图 

了解概念模型如何转换逻辑模型  

实验项目 2：金蝶 KIS 账套管理 

1、教学内容提要 

熟悉金蝶 KIS 账套管理内容 

2、教学目标要求 

熟悉金蝶 KIS 专业版的演示帐套业务 

掌握帐套管理系统的基本操作方法 

实验项目 3：金蝶 KIS 系统初始化 

1、教学内容提要 

金蝶 KIS 参数及资料设置 

2、教学目标要求 
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熟悉金蝶 KIS 专业版演示帐套的系统参数设置和基础资料设置 

掌握新建帐套系统参数设置、引入会计科目和基础资料设置的基本操作方法 

实验项目 4：金蝶 KIS 基本业务模块及应用 

1、教学内容提要 

金蝶 KIS 业务模块操作流程 

2、教学目标要求 

熟悉金蝶 KIS 专业版的基本业务模块操作流程 

熟悉 ERP 系统的各类业务单据 

三、考核方式与成绩评定 

1、考核方式  系统操作 

2、成绩评定 实验报告 50%+系统操作 50% 

四、主要仪器设备及实验材料 

项目编号 实验项目名称 
主要仪器设备 

及台（套）数 
实验材料 备注 

1212020230201 Access 数据库设计实验 计算机 1 人 1 台套 无  

1212020230202  金蝶 KIS 账套管理 计算机 1 人 1 台套 无  

1212020230203  金蝶 KIS 系统初始化 计算机 1 人 1 台套 无  

1212020230204 
金蝶 KIS 基本业务模块及应

用 
计算机 1 人 1 台套 无  

五、教材及参考书 

教  材：《管理信息系统》（第 1 版），毛光喜编著，吉林大学出版社，2013 年。 

参考书：《管理信息系统：基础、应用与方法》，毛基业编著，清华大学出版社，2011 年。 

《数据库原理及应用》（第 1 版），李俊山编著，清华大学出版社，2009 年。 

六、教改说明及其他 

无 

 

大 纲 制 定 人：  吴 满 意  

大 纲 审 定 人：   何 叶 荣  

制 定 时 间：  2 0 1 6 年 5 月  

（此处加盖院系公章）                     
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管理信息系统实验教学大纲（卓越） 

课程编号：12120202302             课程属性：必修 

实验学时： 18                     实验个数： 4 

学    分： 1                      开课学期： 4      

适用专业： 市场营销专业（卓越）           

课程简介：  

通过该课程的学习和实验，学生应能够熟悉管理信息系统设计开发过程，制作较为详细的管理信息

系统设计报告，在此过程中认识到管理信息系统的科学性和严谨性。 

一、实验项目设置及学时分配 

项目编号 实验项目名称 
实验 

类型 

开出 

要求 

学时 

分配 

每组 

人数 

1212020230201 Access 数据库设计实验 综合 必做 4 1 

1212020230202  金蝶 KIS 账套管理 验证 必做 4 1 

1212020230203  金蝶 KIS 系统初始化 验证 必做 4 1 

1212020230204  金蝶 KIS 基本业务模块及应用 验证 必做 6 1 

学时总计 18 

二、实验内容及教学要求 

实验项目 1：数据库系统基础操作 

1、教学内容提要 

利用 Access 软件建立目标数据库 

2、教学目标要求 

掌握 ACCESS 建立企业管理系统数据库的基本技能 

熟练绘制 E-R 图 

了解概念模型如何转换逻辑模型  

实验项目 2：金蝶 KIS 账套管理 

1、教学内容提要 

熟悉金蝶 KIS 账套管理内容 

2、教学目标要求 

熟悉金蝶 KIS 专业版的演示帐套业务 

掌握帐套管理系统的基本操作方法 

实验项目 3：金蝶 KIS 系统初始化 

1、教学内容提要 

金蝶 KIS 参数及资料设置 

2、教学目标要求 

熟悉金蝶 KIS 专业版演示帐套的系统参数设置和基础资料设置 
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掌握新建帐套系统参数设置、引入会计科目和基础资料设置的基本操作方法 

实验项目 4：金蝶 KIS 基本业务模块及应用 

1、教学内容提要 

金蝶 KIS 业务模块操作流程 

2、教学目标要求 

熟悉金蝶 KIS 专业版的基本业务模块操作流程 

熟悉 ERP 系统的各类业务单据 

三、考核方式与成绩评定 

1、考核方式  系统操作 

2、成绩评定 实验报告 50%+系统操作 50% 

四、主要仪器设备及实验材料 

项目编号 实验项目名称 
主要仪器设备 

及台（套）数 
实验材料 备注 

1212020230201 Access 数据库设计实验 计算机 1 人 1 台套 无  

1212020230202  金蝶 KIS 账套管理 计算机 1 人 1 台套 无  

1212020230203  金蝶 KIS 系统初始化 计算机 1 人 1 台套 无  

1212020230204 
金蝶 KIS 基本业务模块及应

用 
计算机 1 人 1 台套 无  

五、教材及参考书 

教  材：《管理信息系统》（第 1 版），毛光喜编著，吉林大学出版社，2013 年。 

参考书：《管理信息系统：基础、应用与方法》，毛基业编著，清华大学出版社，2011 年。 

《数据库原理及应用》（第 1 版），李俊山编著，清华大学出版社，2009 年。 

六、教改说明及其他 

无 

 

大 纲 制 定 人：  吴 满 意  

大 纲 审 定 人：   何 叶 荣  

制 定 时 间：  2 0 1 6 年 5 月  

（此处加盖院系公章）                     
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推销理论与实务实验教学大纲（对口） 

课程编号： 12120202303             课程属性：  必修     

实验学时：   18                    实验个数：    6 

学    分：   1                     开课学期：    4    

适用专业：   市场营　（对口）         

课程简介：推销理论与实务是市场营销专业的专业核心课，本大纲是根据市场营销专业的教学要求

而制定的，以推销实务基本理论为主要内容，重在将推销实务理论知识和实际操作相结合，学生通过实

验，配合《推销实务与实务》课程的课堂学习，加深对书本知识的理解，使学生既有一定的理论知识，

又有推销方面的实战能力，圆满地完成这门课程的学习任务，达到教学大纲的要求。通过对模拟推销各

环节实训的操作，使学生系统地掌握现代推销的全过程，从而加强对所学推销理论知识的理解与认识，

完成从理论到实践的认知过程。 

一、实验项目设置及学时分配 

项目编号 实验项目名称 
实验 

类型 

开出 

要求 

学时 

分配 

每组 

人数 

1212020230301 推销基本素质与礼仪 综合 必修 2 8 

1212020230302 推销模式运用 设计 必修 2 8 

1212020230303 推销接近方法 综合 必修 3 8 

1212020230304 推销洽谈与产品介绍 综合 必修 3 8 

1212020230305 顾客异议处理技巧 设计 必修 3 8 

1212020230306 推销成交促成 设计 必修 3 8 

学时总计 18 

二、实验内容及教学要求 

实验项目 1：推销基本素质与礼仪 

1、教学内容提要 

假设你的某电脑销售公司的推销员，第一次上门拜访某企业客户，演示从敲门到交谈到离开的完整

过程，演示时间 5 分钟。 

2、教学目标要求 

掌握推销人员应该具备的基本素质和礼仪。在五分钟内遵循推销人员应具备的基本素质和礼仪完成

一套完整推销演练过程。 

实验项目 2：推　模式　用 

1、教学内容提要 

学生分组，每个小组确定一件具体的推销产品，利用角色设定的方式进行以上四种模式的推销模拟

实训。每个小组进行完第一轮模式实训后同组内组员交换角色，进行第二轮模拟实训。通过两轮实训，

由小组讨论总结出四种模式的差别和各自优势在哪，形成 WORD 文档。 

2、教学目标要求 
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熟悉爱达模式、迪伯达模式、埃德帕模式、费比模式的程序和运营。学生按照分组要求，每个小组

选一个具体产品作为研究的样本，根据小组市场调研的情况，分别运用爱达模式、迪伯达模式、埃德帕

模式、费比模式自行模拟产品的推销过程，并通过小组讨论找出每个模式的特点和优势。最后以小组为

单位，形成 WORD 文档。 

    实验项目 3：推销接近方法 

1、教学内容提要 

教师可向学生给出市场上某行业、某企业、某类产品相关资料资料，便于学生实践训练时参考。在

教师指导下，每一小组选取并确定五种接近顾客的方法，然后开始模拟情景实训。模拟情景结束后以小

组为单位组织讨论模拟过程中每个方法的优缺点和小组成员模拟过程中的不足。 

2、教学目标要求 

学习接近顾客的准备工作、约见顾客的内容和方法、接近顾客的策略和方法。虚拟一个或寻找一个

现实中的产品，用五种以上的方法接近顾客。 

实验项目 4：推销洽谈与产品介绍 

1、教学内容提要 

每个小组做好推销洽谈前的方案准备（书面化），设计若干组问题并评价其有效性。在正式推销洽

谈中模拟各种情形，双方可以一方面以各种方式表示或掩饰自己的方法和意图，一方面观察对方，了解

其真实想法。事后可进行验证。洽谈模拟结束后以小组为单位谈论总结各自推销洽谈过程中的优缺点。 

2、教学目标要求 

学生分组，确定某特定产品进行模拟推销洽谈训练，并力求在洽谈过程中完整的传达产品相关信息,

熟练推销洽谈的方法和技巧。 

实验项目 5：顾客异议处理技巧 

1、教学内容提要 

假定为某手机公司推销员，要向顾客推销手机，根据推销产品设定问题并在试训中模拟解决问题。

设定买主向推销员提出三个异议。小组成员选择三个不同的方法分别处理以上三个异议。针对每个异议

的处理进行记录，然后小组讨论处理方式是否合理。 

2、教学目标要求 

理解顾客异议产生的原因，掌握顾客异议处理的方法。。 

实验项目 6：推销成交促成 

1、教学内容提要 

虚拟一个企业和产品，模拟推销成交环节。分小组虚拟一个企业和产品，模拟推销洽谈的最后环节；

每组选择一种成交方法，模拟成交过程；小组间互相评比，分析每一种方法的利弊及使用时应注意的问

题。 

2、教学目标要求 

掌握成交促成的方式方法，熟悉成交技能。 

三、考核方式与成绩评定 

1、考核方式 

为了加强学生对实验教学的重视程度，促进实验教学质量不断提高，本课程实验教学要进行考核并

评定等级。根据学生的现场实验结果和实验报告综合决定该学生的实验成绩。每个实验，实验报告占

30%，实际操作 40%，总结报告 30%，根据学生完成的各个实验的成绩，算出其平均分数，最后得出该学
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生的实验成绩。 

2、成绩评定 

实验成绩分：优（90—100 分）、良（80—89 分）、中（70—79 分）、及格（60—69 分）、不及格

（60 分以下）五级。实验成绩计入课程总成绩，实验成绩不合格者不能参加所属理论课程考试。实验缺

课学时达 1/4 以上者，不得参加该门课程的考核。实验成绩的评分要力求作到认真、客观、公正。考核结

果要记录存挡。  

四、主要仪器设备及实验材料 

项目编号 实验项目名称 
主要仪器设备 

及台（套）数 
实验材料 备注 

1212020230301 推销基本素质与礼仪 投影仪、电脑（各一台） 实验报告  

1212020230302 推销模式运用 投影仪、电脑（各一台） 实验报告  

1212020230303 推销接近方法 投影仪、电脑（各一台） 实验报告  

1212020230304 推销洽谈与产品介绍 投影仪、电脑（各一台） 实验报告  

1212020230305 顾客异议处理技巧 投影仪、电脑（各一台） 实验报告  

1212020230306 推销成交促成 投影仪、电脑（各一台） 实验报告  

五、教材及参考书 

教  材：《现代推销理论与实务》（第一版），王亮、何叶荣编著，中国科技大学出版社，2014 年。 

参考书：《推销实务》（第一版），谢和书编著，中国人民大学出版社，2016 年。 

《推销理论与技巧》（第一版），卢晶编著，清华大学出版社，2015 年。  

六、教改说明及其他 

无 

大 纲 制 定 人 ： 裴 飞 云 

大 纲 审 定 人 ： 何 叶 荣  

制 定 时 间 ：  2 0 1 6 年 5 月  

（此处加盖院系公章）                     
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推销理论与实务实验教学大纲（卓越） 

课程编号： 12120202303             课程属性：  必修     

实验学时：   18                    实验个数：    6 

学    分：   1                     开课学期：    4    

适用专业：   市场营　（卓越）         

课程简介：推销理论与实务是市场营销专业的专业核心课，本大纲是根据市场营销专业的教学要求

而制定的，以推销实务基本理论为主要内容，重在将推销实务理论知识和实际操作相结合，学生通过实

验，配合《推销实务与实务》课程的课堂学习，加深对书本知识的理解，使学生既有一定的理论知识，

又有推销方面的实战能力，圆满地完成这门课程的学习任务，达到教学大纲的要求。通过对模拟推销各

环节实训的操作，使学生系统地掌握现代推销的全过程，从而加强对所学推销理论知识的理解与认识，

完成从理论到实践的认知过程。 

一、实验项目设置及学时分配 

项目编号 实验项目名称 
实验 

类型 

开出 

要求 

学时 

分配 

每组 

人数 

1212020230301 推销基本素质与礼仪 综合 必修 2 8 

1212020230302 推销模式运用 设计 必修 2 8 

1212020230303 推销接近方法 综合 必修 3 8 

1212020230304 推销洽谈与产品介绍 综合 必修 3 8 

1212020230305 顾客异议处理技巧 设计 必修 3 8 

1212020230306 推销成交促成 设计 必修 3 8 

学时总计 18 

二、实验内容及教学要求 

实验项目 1：推销基本素质与礼仪 

1、教学内容提要 

假设你的某电脑销售公司的推销员，第一次上门拜访某企业客户，演示从敲门到交谈到离开的完整

过程，演示时间 5 分钟。 

2、教学目标要求 

掌握推销人员应该具备的基本素质和礼仪。在五分钟内遵循推销人员应具备的基本素质和礼仪完成

一套完整推销演练过程。 

实验项目 2：推　模式　用 

1、教学内容提要 

学生分组，每个小组确定一件具体的推销产品，利用角色设定的方式进行以上四种模式的推销模拟

实训。每个小组进行完第一轮模式实训后同组内组员交换角色，进行第二轮模拟实训。通过两轮实训，

由小组讨论总结出四种模式的差别和各自优势在哪，形成 WORD 文档。 

2、教学目标要求 
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熟悉爱达模式、迪伯达模式、埃德帕模式、费比模式的程序和运营。学生按照分组要求，每个小组

选一个具体产品作为研究的样本，根据小组市场调研的情况，分别运用爱达模式、迪伯达模式、埃德帕

模式、费比模式自行模拟产品的推销过程，并通过小组讨论找出每个模式的特点和优势。最后以小组为

单位，形成 WORD 文档。 

    实验项目 3：推销接近方法 

1、教学内容提要 

教师可向学生给出市场上某行业、某企业、某类产品相关资料资料，便于学生实践训练时参考。在

教师指导下，每一小组选取并确定五种接近顾客的方法，然后开始模拟情景实训。模拟情景结束后以小

组为单位组织讨论模拟过程中每个方法的优缺点和小组成员模拟过程中的不足。 

2、教学目标要求 

学习接近顾客的准备工作、约见顾客的内容和方法、接近顾客的策略和方法。虚拟一个或寻找一个

现实中的产品，用五种以上的方法接近顾客。 

实验项目 4：推销洽谈与产品介绍 

1、教学内容提要 

每个小组做好推销洽谈前的方案准备（书面化），设计若干组问题并评价其有效性。在正式推销洽

谈中模拟各种情形，双方可以一方面以各种方式表示或掩饰自己的方法和意图，一方面观察对方，了解

其真实想法。事后可进行验证。洽谈模拟结束后以小组为单位谈论总结各自推销洽谈过程中的优缺点。 

2、教学目标要求 

学生分组，确定某特定产品进行模拟推销洽谈训练，并力求在洽谈过程中完整的传达产品相关信息,

熟练推销洽谈的方法和技巧。 

实验项目 5：顾客异议处理技巧 

1、教学内容提要 

假定为某手机公司推销员，要向顾客推销手机，根据推销产品设定问题并在试训中模拟解决问题。

设定买主向推销员提出三个异议。小组成员选择三个不同的方法分别处理以上三个异议。针对每个异议

的处理进行记录，然后小组讨论处理方式是否合理。 

2、教学目标要求 

理解顾客异议产生的原因，掌握顾客异议处理的方法。。 

实验项目 6：推销成交促成 

1、教学内容提要 

虚拟一个企业和产品，模拟推销成交环节。分小组虚拟一个企业和产品，模拟推销洽谈的最后环节；

每组选择一种成交方法，模拟成交过程；小组间互相评比，分析每一种方法的利弊及使用时应注意的问

题。 

2、教学目标要求 

掌握成交促成的方式方法，熟悉成交技能。 

三、考核方式与成绩评定 

1、考核方式 

为了加强学生对实验教学的重视程度，促进实验教学质量不断提高，本课程实验教学要进行考核并

评定等级。根据学生的现场实验结果和实验报告综合决定该学生的实验成绩。每个实验，实验报告占

30%，实际操作 40%，总结报告 30%，根据学生完成的各个实验的成绩，算出其平均分数，最后得出该学
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生的实验成绩。 

2、成绩评定 

实验成绩分：优（90—100 分）、良（80—89 分）、中（70—79 分）、及格（60—69 分）、不及格

（60 分以下）五级。实验成绩计入课程总成绩，实验成绩不合格者不能参加所属理论课程考试。实验缺

课学时达 1/4 以上者，不得参加该门课程的考核。实验成绩的评分要力求作到认真、客观、公正。考核结

果要记录存挡。  

四、主要仪器设备及实验材料 

项目编号 实验项目名称 
主要仪器设备 

及台（套）数 
实验材料 备注 

1212020230301 推销基本素质与礼仪 投影仪、电脑（各一台） 实验报告  

1212020230302 推销模式运用 投影仪、电脑（各一台） 实验报告  

1212020230303 推销接近方法 投影仪、电脑（各一台） 实验报告  

1212020230304 推销洽谈与产品介绍 投影仪、电脑（各一台） 实验报告  

1212020230305 顾客异议处理技巧 投影仪、电脑（各一台） 实验报告  

1212020230306 推销成交促成 投影仪、电脑（各一台） 实验报告  

五、教材及参考书 

教  材：《现代推销理论与实务》（第一版），王亮、何叶荣编著，中国科技大学出版社，2014 年。 

参考书：《推销实务》（第一版），谢和书编著，中国人民大学出版社，2016 年。 

《推销理论与技巧》（第一版），卢晶编著，清华大学出版社，2015 年。  

六、教改说明及其他 

无 

大 纲 制 定 人 ： 裴 飞 云 

大 纲 审 定 人 ： 何 叶 荣  

制 定 时 间 ：  2 0 1 6 年 5 月  

                                                                                    （此处加盖院系公章） 
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网络营销实验课程教学大纲（对口） 

课程编号：12120202305               课程属性：专业必修课 

实验学时：18                        实验个数：4 

学    分：1                         开课学期：5  

适用专业：市场营　（对口） 

课程简介：  

本课程属于专业必修课，电子商务学科实践性教学中重要环节，通过实验，使学生为学习和掌握

其他课程打好基础，并可以为学生毕业走上工作岗位后，缩短“适应期”，胜任工作奠定扎实的基础。 

为了使学生更好地理解和深刻地把握网络营销相关知识，本实验教学目标与基本要求是：通过本

实验课程的学习，分别开展网络营销策划实战训练和网络营销基本技能训练，让学生通过上网实习，熟

悉企业网络营销活动常用工具及方法，掌握网络市场调研的技巧与方法，掌握制定网络营销策略的方法

和实施网络营销的程序，能够进行简单的企业网络营销策划和建设工作，具备从事网络营销的能力。 

一、实验项目设置及学时分配 

项目编号 实验项目名称 
实验 

类型 

开出 

要求 

学时 

分配 

1212020230501  网络营销导向的企业网站建设  综合性 必做 4 

1212020230502  搜索引擎营销  综合性 必做 6 

1212020230503  网络广告  综合性 必做 4 

1212020230504  网络营销效果评价  综合性 必做 4 

学时总计 18 

二、实验内容及教学要求 

实验项目 1：网络营销导向的企业网站建设 

1、教学内容提要 

（1）了解网站评估的主要内容与评估标准。 

（2）选取有代表性的电子商务网站，对该网站的网络营销职能进行综合评估。 

2、教学目标要求 

通过对给定企业网站的了解、认识、分析和评价，理解企业网站的概念、作用，进而从企业网站

的结构、内容及其功能和服务等方面认识企业网站对企业网络营销的重要作用和意义。 

实验项目 2：搜索引擎营销 

1、教学内容提要 

（1）搜索引擎的手工注册； 

（2）搜索引擎自动注册软件（网站登录专家和网站推广专家）的下载、安装和使用； 

（3）搜索引擎优化的相关技巧 

2、教学目标要求 

（1）掌握搜索引擎的类型及工作原理； 

（2）掌握搜索引擎自动注册软件（网站登录专家和网站推广专家）的下载、安装和使用； 

（3）掌握搜索引擎优化的方法技巧。 
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实验项目 3：网络广告 

1、教学内容提要 

（1）几种常见形式的网络广告（Banner，浮游广告、Pop-up）； 

（2）的设计、制作并在你的网站上发布； 

（3）在可以免费发布广告的站点，发布你所制作的广告，跟同行网站建立交换链接，将你的网站

提交到分类广告站点和广告交换网； 

（4）搜索下载并安装信息发布专家（环球商务信息发布系统），利用该软件将你的网站信息发布

到互联网，打印出发布成功的原始界面。 

2、教学目标要求 

（1）了解网络广告的形式、优缺点； 

（2）掌握常见形式网络广告的设计、制作和发布； 

（3）掌握分类广告站点、交换链接的使用。 

（4）掌握信息发布专家软件的下载安装和使用。 

实验项目 4：网络营销效果评价 

1、教学内容提要 

（1）选择一个知名企业（如海尔、联想、伊利、可口可乐、百度等），对其网络营销效果进行评

价； 

（2）分析网络营销效果形成的主要原因。 

2、教学目标要求 

熟练掌握网络营销效果评价的主要方法。 

三、考核方式及要求 

1、考核方式 

本课程为考试课，实验课程考试方法由上机操作和实验报告两大块组成； 

2、成绩评定 

上机操作占 70%，实验报告成绩占 30%。 

四、主要仪器设备及实验材料 

项目编号 实验项目名称 
主要仪器设备 

及台（套）数 
实验材料 备注 

1212020230501 
网络营销导向的企业网站

建设 
联网计算机及相关软件 计算机耗材  

1212020230502  搜索引擎营销  联网计算机及相关软件 计算机耗材  

1212020230503  网络广告  联网计算机及相关软件 计算机耗材  

1212020230504  网络营销效果评价  联网计算机及相关软件 计算机耗材  

五、教材及参考书 

使用教材 名称 主编 出版社 

1 网络营销基础与实践 冯英健 清华大学出版社 

使用参考书 名称 主编 出版社 

1 网络营销基础 王耀球 清华大学出版社 

2 网络营销技术基础 段健 机械工业出版社 
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六、教改说明及其他 

 

 

大纲制定人：   杨渊  

大纲审定人：   
何 叶 荣  

制 定 时 间：  
20 1 6 年 5 月  
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网络营销实验课程教学大纲（卓越） 

课程编号：12120202305               课程属性：专业必修课 

实验学时：18                        实验个数：4 

学    分：1                         开课学期：5  

适用专业：市场营　（卓越） 

课程简介：  

本课程属于专业必修课，电子商务学科实践性教学中重要环节，通过实验，使学生为学习和掌握

其他课程打好基础，并可以为学生毕业走上工作岗位后，缩短“适应期”，胜任工作奠定扎实的基础。 

为了使学生更好地理解和深刻地把握网络营销相关知识，本实验教学目标与基本要求是：通过本

实验课程的学习，分别开展网络营销策划实战训练和网络营销基本技能训练，让学生通过上网实习，熟

悉企业网络营销活动常用工具及方法，掌握网络市场调研的技巧与方法，掌握制定网络营销策略的方法

和实施网络营销的程序，能够进行简单的企业网络营销策划和建设工作，具备从事网络营销的能力。 

一、实验项目设置及学时分配 

项目编号 实验项目名称 
实验 

类型 

开出 

要求 

学时 

分配 

1212020230501  网络营销导向的企业网站建设  综合性 必做 4 

1212020230502  搜索引擎营销  综合性 必做 6 

1212020230503  网络广告  综合性 必做 4 

1212020230504  网络营销效果评价  综合性 必做 4 

学时总计 18 

二、实验内容及教学要求 

实验项目 1：网络营销导向的企业网站建设 

1、教学内容提要 

（1）了解网站评估的主要内容与评估标准。 

（2）选取有代表性的电子商务网站，对该网站的网络营销职能进行综合评估。 

2、教学目标要求 

通过对给定企业网站的了解、认识、分析和评价，理解企业网站的概念、作用，进而从企业网站

的结构、内容及其功能和服务等方面认识企业网站对企业网络营销的重要作用和意义。 

实验项目 2：搜索引擎营销 

1、教学内容提要 

（1）搜索引擎的手工注册； 

（2）搜索引擎自动注册软件（网站登录专家和网站推广专家）的下载、安装和使用； 

（3）搜索引擎优化的相关技巧 

2、教学目标要求 

（1）掌握搜索引擎的类型及工作原理； 

（2）掌握搜索引擎自动注册软件（网站登录专家和网站推广专家）的下载、安装和使用； 
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（3）掌握搜索引擎优化的方法技巧。 

实验项目 3：网络广告 

1、教学内容提要 

（1）几种常见形式的网络广告（Banner，浮游广告、Pop-up）； 

（2）的设计、制作并在你的网站上发布； 

（3）在可以免费发布广告的站点，发布你所制作的广告，跟同行网站建立交换链接，将你的网站

提交到分类广告站点和广告交换网； 

（4）搜索下载并安装信息发布专家（环球商务信息发布系统），利用该软件将你的网站信息发布

到互联网，打印出发布成功的原始界面。 

2、教学目标要求 

（1）了解网络广告的形式、优缺点； 

（2）掌握常见形式网络广告的设计、制作和发布； 

（3）掌握分类广告站点、交换链接的使用。 

（4）掌握信息发布专家软件的下载安装和使用。 

实验项目 4：网络营销效果评价 

1、教学内容提要 

（1）选择一个知名企业（如海尔、联想、伊利、可口可乐、百度等），对其网络营销效果进行评

价； 

（2）分析网络营销效果形成的主要原因。 

2、教学目标要求 

熟练掌握网络营销效果评价的主要方法。 

三、考核方式及要求 

1、考核方式 

本课程为考试课，实验课程考试方法由上机操作和实验报告两大块组成； 

2、成绩评定 

上机操作占 70%，实验报告成绩占 30%。 

四、主要仪器设备及实验材料 

项目编号 实验项目名称 
主要仪器设备 

及台（套）数 
实验材料 备注 

1212020230501 
网络营销导向的企业网站

建设 
联网计算机及相关软件 计算机耗材  

1212020230502  搜索引擎营销  联网计算机及相关软件 计算机耗材  

1212020230503  网络广告  联网计算机及相关软件 计算机耗材  

1212020230504  网络营销效果评价  联网计算机及相关软件 计算机耗材  

五、教材及参考书 

使用教材 名称 主编 出版社 

1 网络营销基础与实践 冯英健 清华大学出版社 

使用参考书 名称 主编 出版社 



 
 

  16

1 网络营销基础 王耀球 清华大学出版社 

2 网络营销技术基础 段健 机械工业出版社 

 

六、教改说明及其他 

 

 

大纲制定人：   杨渊  

大纲审定人：   
何 叶 荣  

制 定 时 间：  
20 1 6 年 5 月  
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人力资源管理实验教学大纲（对口） 

课程编号：12120202401                课程属性：必修       

实验学时：18                         实验个数：8 

学    分： 1                         开课学期：5 

适用专业：市场营销（对口）  

课程简介：  

《人力资源管理》实验课程是管理类各专业培养计划的主干课程之一，任务是通过人力资源管理专

业软件使学生掌握人力资源管理的基本理论和可操作的方法，并初步具有企业人力资源管理的能力。本

课程是让学生在掌握人力资源管理的基本知识和技能的基础上，运用人力资源管理软件，掌握具体的人

力资源管理技术。包括通过人力资源管理信息系统对员工进行基本的人事管理；进行人力资源需求与供

给预测；学会工作分析，掌握工作说明书的撰写；开展人才测评，进行有效的员工招聘与培训；使用计

算机进行员工绩效考评和员工薪酬管理。 

一、实验项目设置及学时分配 

项目编号 实验项目名称 
实验 

类型 

开出 

要求 

学时 

分配 

每组 

人数 

1212020240101 能力倾向测验 验证 必修 2 1 

1212020240102 人力资源供求预测与平衡 综合 必修 2 1 

1212020240103 职业适应性测验 验证 必修 2 1 

1212020240104 职位说明书的编写 综合 必修 2 1 

1212020240105 管理行为测验 验证 必修 2 1 

1212020240106 简历的制作与筛选 综合 必修 2 1 

1212020240107 人才评价中心实验 综合 必修 4 1 

1212020240108 培训管理模拟实验 综合 必修 2 1 

学时总计 18 

 

二、实验内容及教学要求 

实验项目 1：能力倾向测验 

1、教学内容提要 

理论层面：回顾相关理论知识：人力资源管理发展的阶段；国内外的人力资源管理思想；人力资源

管理的现状及趋势。 

实践层面：了解北森人力资源管理软件的组成，熟悉人力资源管理软件的基本原理，掌握人力资源

管理软件的安装与使用方法。 

2、教学目标要求 
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（1）了解北森人力资源管理软件的组成、熟悉人力资源管理软件的基本原理、掌握人力资源管理

软件基础业务的使用方法； 

（2）熟悉学习能力的定义、能力测验的作用和能力的相关理论； 

（3）了解各种能力之间的差别；了解自己的能力水平；掌握能力测验在相关人力资源环节中的应

用。 

实验项目 2：人力资源供求预测与平衡 

1、教学内容提要 

通过企业背景资料的分析，明确人力资源规划在企业中的重要作用；掌握人力资源供求不平衡时

需要采取的措施。 

2、教学目标要求 

（1）了解人力资源预测的概念； 

（2）熟悉影响人力资源供求的主要因素； 

（3）掌握人力资源供求预测的基本方法、流程以及平衡人员供求的主要方式。 

实验项目 3：职业适应性测验 

1、教学内容提要 

讲解麦克利兰动机理论、职业兴趣、职业锚和 SCL-90 等理论基本内容 

2、教学目标要求 

（1）了解常用的职业适应性测验； 

（2）熟悉麦克利兰动机理论、职业兴趣、职业锚和 SCL-90 的基本内容，能够借助职业适应性测验

了解自己和他人的特点； 

（3）掌握在人力资源管理环节中，借助相关工具和资源，有意识地运用职业适应性测验进行考查

和评估，辅助人员招聘选拔、员工激励等。 

实验项目 4：职位说明书的编写 

1、教学内容提要 

讲解工作分析理论知识、学习工作分析的具体方法；就工作分析成果之一职位说明书进行重点 

讲解。 

2、教学目标要求 

（1）了解职位说明书的概念及构成； 

（2）熟悉编写职位说明书的基本原理和基本思路； 

（3）掌握几种职位说明书的编写方法，并形成实验报告。 

实验项目 5：管理行为测验 

1、教学内容提要 

阐述情境领导模型的基本内容，说明四种领导风格和准备水平的主要特征及关系。 

2、教学目标要求 

（1）借助管理行为测验了解自己和他人的领导力、领导风格和冲突对应风格； 

（2）掌握在人力资源管理工作中，能够借助相关工具和资源，有意识地运用管理行为测验对人员

的相关特征进行考查和评估，辅助管理人员的招聘选拔和培训发展等工作。 

 

实验项目 6：简历的制作与筛选 
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1、教学内容提要 

人力资源招聘的定义，及其对企业发展的意义；人力资源招聘与选拔的程序；认识求职简历的基本

模式。 

2、教学目标要求 

（1）了解如何发布公司信息和人才信息； 

（2）掌握公司实施招聘人才及求职者应聘岗位； 

（3）掌握人力资源管理招聘的基本内容和知识，具备组织和实施企业人力资源招聘工作的基本能

力； 

（4）掌握求职简历编制的基本要求和简历包含的主要内容； 

（5）了解企业招聘时如何筛选简历，学习简历中虚假信息的辨别方法。 

实验项目 7：人才评价中心实验 

1、教学内容提要 

学习人才测评中招聘面试的意义、类型；常用的测评方法及标准量表；评价中心、胜任力模型构建。 

2、教学目标要求 

（1）通过北森人力资源实践教学系统，了解人才测评的目的、意义及类型； 

（2）掌握履历分析、心理测验、结构化面试、无领导小组讨论、公文筐测验的实操流程与方法，

从而进行有效的人力资源测评和选拔； 

（3）了解结构化面试和无领导小组讨论的流程和技巧； 

（4）掌握人力资源管理招聘的基本内容和知识，具备组织和实施企业人力资源招聘工作的基本能

力。 

 

实验项目 8：培训管理模拟实验 

1、教学内容提要 

员工培训重要意义、原则、过程；评估培训结果的方法 

2、教学目标要求 

（1）了解人力资源培训管理的基本内容和知识； 

（2）熟悉人力资源管理中培训管理模块基本原理； 

（3）掌握具备设定各个培训项目、培训方案和培训考评的能力。 

 

三、考核方式与成绩评定 

1、考核方式 

考核方式为考查。“平时+笔试+操作”考核方式。强调学生平时实验表现，同时，考查学生的实验

原理理解与实际动手操作能力。 

2、成绩评定 

学生成绩评定方法为：平时成绩和最后实验成绩的加权平均（其中操作成绩：学生模拟人力资源的

各个处理环节，依老师指定的职业类别和招聘者信息进行测评判断，以判断结果评分；写出实验报告并

记入成绩。） 
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四、主要仪器设备及实验材料 

项目编号 实验项目名称 
主要仪器设备 

及台（套）数 
实验材料 备注 

1212020240101 能力倾向测验 电脑（100 台）、软件、投影   

1212020240102 人力资源供求预测与平衡 电脑（100 台）、软件、投影   

1212020240103 职业适应性测验 电脑（100 台）、软件、投影   

1212020240104 职位说明书的编写 电脑（100 台）、软件、投影   

1212020240105 管理行为测验 电脑（100 台）、软件、投影   

1212020240106 简历的制作与筛选 电脑（100 台）、软件、投影   

1212020240107 人才评价中心实验 电脑（100 台）、软件、投影   

1212020240108 培训管理模拟实验 电脑（100 台）、软件、投影   

 

五、教材及参考书 

教  材：《人力资源管理实验教程》（第 1 版），翟海燕编著，中国财政经济出版社，2012 年。 

参考书：《人力资源管理》（第 1版），奚昕编著，安徽大学出版社，2012 年。 

六、教改说明及其他 

实验所用软件：北森人力资源测评教学系统 

 

 

大 纲 制 定 人：   杨 霞  

大 纲 审 定 人：   何 叶 荣  

制 定 时 间：  2 0 1 6 年 5 月
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人力资源模拟实验教学大纲（卓越） 

课程编号：12120202605                课程属性：必修       

实验学时：36                         实验个数：10 

学    分：2                          开课学期：7 

适用专业：市场营销（卓越）   

课程简介：  

《人力资源模拟实验》实验课程是管理类各专业培养计划的主干课程之一，任务是通过人力资源

管理专业软件使学生掌握人力资源管理的基本理论和可操作的方法，并初步具有企业人力资源管理的能

力。本课程是让学生在掌握人力资源管理的基本知识和技能的基础上，运用人力资源管理软件，掌握具

体的人力资源管理技术。包括通过人力资源管理信息系统对员工进行基本的人事管理；进行人力资源需

求与供给预测；学会工作分析，掌握工作说明书的撰写；开展人才测评，进行有效的员工招聘与培训；

使用计算机进行员工绩效考评和员工薪酬管理。 

一、实验项目设置及学时分配 

项目编号 实验项目名称 
实验 

类型 

开出 

要求 

学时 

分配 

每组 

人数 

1212020260501 能力倾向测验 验证 必修 2 1 

1212020260502 人力资源供求预测与平衡 综合 必修 4 1 

1212020260503 职业适应性测验 验证 必修 4 1 

1212020260504 职位说明书的编写 综合 必修 4 1 

1212020260505 管理行为测验 验证 必修 2 1 

1212020260506 简历的制作与筛选 综合 必修 4 1 

1212020260507 人才评价中心实验 综合 必修 4 1 

1212020260508 培训管理模拟实验 综合 必修 4 1 

1212020260509 绩效管理模拟实验 综合 选修 4 1 

1212020260510 薪酬管理模拟实验 综合 选修 4 1 

学时总计 36 

二、实验内容及教学要求 

实验项目 1：能力倾向测验 

1、教学内容提要 

理论层面：回顾相关理论知识：人力资源管理发展的阶段；国内外的人力资源管理思想；人力资源

管理的现状及趋势。 

实践层面：了解北森人力资源管理软件的组成，熟悉人力资源管理软件的基本原理，掌握人力资源

管理软件的安装与使用方法。 
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2、教学目标要求 

（1）了解北森人力资源管理软件的组成、熟悉人力资源管理软件的基本原理、掌握人力资源管理

软件基础业务的使用方法； 

（2）熟悉学习能力的定义、能力测验的作用和能力的相关理论； 

（3）了解各种能力之间的差别；了解自己的能力水平；掌握能力测验在相关人力资源环节中的应

用。 

实验项目 2：人力资源供求预测与平衡 

1、教学内容提要 

通过企业背景资料的分析，明确人力资源规划在企业中的重要作用；掌握人力资源供求不平衡时

需要采取的措施。 

2、教学目标要求 

（1）了解人力资源预测的概念； 

（2）熟悉影响人力资源供求的主要因素； 

（3）掌握人力资源供求预测的基本方法、流程以及平衡人员供求的主要方式。 

实验项目 3：职业适应性测验 

1、教学内容提要 

讲解麦克利兰动机理论、职业兴趣、职业锚和 SCL-90 等理论基本内容 

2、教学目标要求 

（1）了解常用的职业适应性测验； 

（2）熟悉麦克利兰动机理论、职业兴趣、职业锚和 SCL-90 的基本内容，能够借助职业适应性测验

了解自己和他人的特点； 

（3）掌握在人力资源管理环节中，借助相关工具和资源，有意识地运用职业适应性测验进行考查

和评估，辅助人员招聘选拔、员工激励等。 

实验项目 4：职位说明书的编写 

1、教学内容提要 

讲解工作分析理论知识、学习工作分析的具体方法；就工作分析成果之一职位说明书进行重点 

讲解。 

2、教学目标要求 

（1）了解职位说明书的概念及构成； 

（2）熟悉编写职位说明书的基本原理和基本思路； 

（3）掌握几种职位说明书的编写方法，并形成实验报告。 

实验项目 5：管理行为测验 

1、教学内容提要 

阐述情境领导模型的基本内容，说明四种领导风格和准备水平的主要特征及关系。 

2、教学目标要求 

（1）借助管理行为测验了解自己和他人的领导力、领导风格和冲突对应风格； 

（2）掌握在人力资源管理工作中，能够借助相关工具和资源，有意识地运用管理行为测验对人员

的相关特征进行考查和评估，辅助管理人员的招聘选拔和培训发展等工作。 

实验项目 6：简历的制作与筛选 
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1、教学内容提要 

人力资源招聘的定义，及其对企业发展的意义；人力资源招聘与选拔的程序；认识求职简历的基本

模式。 

2、教学目标要求 

（1）了解如何发布公司信息和人才信息； 

（2）掌握公司实施招聘人才及求职者应聘岗位； 

（3）掌握人力资源管理招聘的基本内容和知识，具备组织和实施企业人力资源招聘工作的基本能

力； 

（4）掌握求职简历编制的基本要求和简历包含的主要内容； 

（5）了解企业招聘时如何筛选简历，学习简历中虚假信息的辨别方法。 

实验项目 7：人才评价中心实验 

1、教学内容提要 

学习人才测评中招聘面试的意义、类型；常用的测评方法及标准量表；评价中心、胜任力模型构建。 

2、教学目标要求 

（1）通过北森人力资源实践教学系统，了解人才测评的目的、意义及类型； 

（2）掌握履历分析、心理测验、结构化面试、无领导小组讨论、公文筐测验的实操流程与方法，

从而进行有效的人力资源测评和选拔； 

（3）了解结构化面试和无领导小组讨论的流程和技巧； 

（4）掌握人力资源管理招聘的基本内容和知识，具备组织和实施企业人力资源招聘工作的基本能

力。 

实验项目 8：培训管理模拟实验 

1、教学内容提要 

员工培训重要意义、原则、过程；评估培训结果的方法 

2、教学目标要求 

（1）了解人力资源培训管理的基本内容和知识； 

（2）熟悉人力资源管理中培训管理模块基本原理； 

（3）掌握具备设定各个培训项目、培训方案和培训考评的能力。 

实验项目 9：绩效管理模拟实验 

1、教学内容提要 

员工考核、绩效管理的定义；员工考核的内容；考核指标和内容、标准的设计方法。 

2、教学目标要求 

(1)了解人力资源绩效管理的基本内容和知识； 

(2)了解绩效管理原理，具备绩效分析、绩效评估的基本能力； 

(3)掌握设定评估考核标准，对绩效考核效果进行统计分析的方法。 

实验项目 10：薪酬管理模拟实验 

1、教学内容提要 

薪酬管理的基本思想；影响报酬高低的因素；薪酬管理的基本方法；薪酬的有关理论。 

2、教学目标要求 

（1）了解企业薪资情况及薪酬查询； 

（2）熟悉人力资源管理工作中员工的薪资、计件工资、工资总计以及详细信息等内容和相关知识； 

（3）掌握薪酬管理原理，具备公司薪酬设计和薪酬管理的基本能力。 

三、考核方式与成绩评定 
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1、考核方式 

考核方式为考查。“平时+笔试+操作”考核方式。强调学生平时实验表现，同时，考查学生的实验

原理理解与实际动手操作能力。 

2、成绩评定 

学生成绩评定方法为：平时成绩和最后实验成绩的加权平均（其中操作成绩：学生模拟人力资源的

各个处理环节，依老师指定的职业类别和招聘者信息进行测评判断，以判断结果评分；写出实验报告并

记入成绩。） 

四、主要仪器设备及实验材料 

项目编号 实验项目名称 
主要仪器设备 

及台（套）数 
实验材料 备注 

1212020260501 能力倾向测验 电脑（100 台）、软件、投影   

1212020260502 人力资源供求预测与平衡 电脑（100 台）、软件、投影   

1212020260503 职业适应性测验 电脑（100 台）、软件、投影   

1212020260504 职位说明书的编写 电脑（100 台）、软件、投影   

1212020260505 管理行为测验 电脑（100 台）、软件、投影   

1212020260506 简历的制作与筛选 电脑（100 台）、软件、投影   

1212020260507 人才评价中心实验 电脑（100 台）、软件、投影   

1212020260508 培训管理模拟实验 电脑（100 台）、软件、投影   

1212020260509 绩效管理模拟实验 电脑（100 台）、软件、投影   

1212020260510 薪酬管理模拟实验 电脑（100 台）、软件、投影   

五、教材及参考书 

教  材：《人力资源管理实验教程》（第 1 版），翟海燕编著，中国财政经济出版社，2012 年。 

参考书：《人力资源管理》（第 1版），奚昕编著，安徽大学出版社，2012 年。 

六、教改说明及其他 

实验所用软件：北森人力资源测评教学系统 

 

 

大 纲 制 定 人：   杨 霞  

大 纲 审 定 人：   何 叶 荣  

制 定 时 间：   2 0 1 6 年 5 月  
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统计软件应用实验教学大纲 

课程编号： 12020102204            课程属性：专业基础课      

实验学时： 18                     实验个数： 6   

学    分： 1                      开课学期：3        

适用专业：市场营销           

课程简介： 

统计学原理是经济类、管理类本科专业的专业基础课程，也是一门理论性、应用性和实验性极强的

专业课程，通过本课程的学习，为进一步学习经济、管理类其他课程打下坚实的统计方法论基础。通过

实验教学课程，让学生熟练地掌握基本的统计理论、计算方法和统计分析方法，将基本的统计素质转化

为成功素质，为日后走上工作岗位创造优秀的业绩提供有力的支撑。因此，本实验课程的设立就是要使

用学生能够熟练地操作 SPSS 统计软件的统计分析功能，并且能用此软件的统计分析功能计算和分析相

关的经济实例。 

一、实验项目设置及学时分配 

项目编号 实验项目名称 
实验 

类型 

开出 

要求 

学时 

分配 

每组 

人数 

1202010220401 SPSS 数据文件的建立和管理 验证 必修 2 1 

1202010220402 SPSS 数据的预处理 验证 必修 2 1 

1202010220403 SPSS 基本统计分析 验证 必修 4 1 

1202010220404 SPSS 的参数检验 验证 必修 2 1 

1202010220405 SPSS 的相关分析 验证 必修 4 1 

1202010220406 SPSS 的线性回归分析 验证 必修 4 1 

学时总计 18 

二、实验内容及教学要求 

实验项目 1：SPSS 数据文件的建立和管理 

1、教学内容提要 

数据文件的建立与数据录入 

数据文件的编辑整理 

2、教学目标要求 

熟悉 SPSS 的菜单和窗口界面及 SPSS 的数据管理功能。 

3、实验步骤 

 定义变量，建立数据文件 

 输入数据（直接输入，数据库查询导入，文本向导导入） 

 数据的增删 

 变量重新赋值 
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 数据的运算与新变量的生成 

 数据排序 

 数据的行列互换。 

[实验软件]  

SPSS For Windows 

[实验示范讲解]  

[实验独立操作] 

实验二 SPSS 数据的预处理 

1、教学内容提要 

数据的排序 

查找重复个案 

变量计算 

数据选取 

计数 

分类汇总 

数据分组 

数据预处理的其他功能 

2、教学目标要求 

学会 SPSS 数据的基本预处理：排序、分组、分类汇总、变量计算、筛选数据 

3、实验步骤 

 数据排序步骤 

    (1)执行 Data→Sort Cases (观测量分类) 命令，打开 Sort Cases 对话框。 

    (2)从源变量列表框中选择一个或几个分类变量，单击中间的箭头按钮将它们移入 Sort by 框

中，不妨称移入该框的变量为 By 变量。选择 By 变量的意义是将按这个变量对观测量进行分类整理。如

果选择了几个 By 变量，从上至下依次称为第一 By 变量、第二 By 变量等。分类整理将按每一个 By 变量

层叠分类整理。例如，选择了两个分类变量，sex 为第一 By 变量，score 为第二 By 变量，在 sex 的每

一个分类中观测值将按 score 分类。 

    (3)在 Sort Order 栏中选择一种排序方式。如对某分类变量选择 Ascending (升序)，则在 Sort 

by 框里该变量名之后用连线连接 Ascending；如选择 Descending (降序)，该变量名连接 Descending。

各分类变量的排序方式可以不同。 

 (4)以上选择确定后，单击 OK，返回数据窗口，分类排序结果显示于数据窗口内。 

 变量计算的基本操作 

(1)打开数据文件，执行 Transform(转换)→Compute 命令，打开 Compute Variable(计算变量)对

话框。 

    (2)输入计算表达式。使用计算器板(Colculator Pad)或键盘将计算表达式输入到 Numeric 

Expression (数值表达式)栏中，表达式中需要的 SPSS 函数可从 Function (函数) 栏中选择，通过双

击鼠标左键或单击该栏上方的箭头按钮将选中者移入表达式栏。这时，栏中函数的自变量和参数用“?”

提示，自变量必须选用当前工作文件中的变量，可以从源变量清单栏中选择，选中后用鼠标双击它，或

单击栏边的箭头按钮输入表达式中。 

    计算器板上的数字、运算符按钮以及 Delete 按钮与计算机键盘上相应的按钮等效。 

    (3)定义新变量及其类型。 

 数据选取的基本操作 

（1）选择菜单 Data—Select cases 

（2）根据分析需要选择数据选取方法 



 
 

  27

（3）Unselected cases are 指定对未选中个案的处理方式 

Filtered 表示在未被选中的个案号码上打一个“/”标记；  

Deleted 表示将未被选中的个案从数据编辑窗口中删除。   

 计数的基本操作 

    (1)执行 Transform→Count (计数)命令。打开 Count Occurrences Of Values withinCases (对

观测量内的特定值出现次数计数)对话框。 

    在对话框的 Target 框中输入目标变量名，用于保存计数结果。在 Target label 框中输入目标

变量的标签。 

    (2)从源变量列表中选择准备计数的变量移至 Numeric 栏中。这里需要注意，凡移送入该栏的

变量必须具有相同的类型，当移入变量为数值型变量时，该栏标题改为“Numeric Variables”，移入

变量为字符型变量时，标题改为“String Variables'’。 

    (3)如要按变量值来计数，鼠标选中 Variables 框中的变量，单击 Define Values (确定值)按

钮：打开 Count Values within Cases：Values to Count 对话框。 

    对话框 Value 栏中有 6 个单选项，凡移送到 Variables 框中的每个变量，确定计数的变量值或

变量取值范围，并按 Add 按钮移入 Value to Count(按指定值计数)框里。系统将按照设定凡与设定值

或值范围相匹配的就计数一次，并给目标变量增加数值 1。 

  选择确定后，单击 Add 按钮移送到 Value to Count 框里，如需改变选择，可以单击按钮 Change

更改或单击按钮 Remove 移出。最后，单击 Continue 按钮返回主对话框。 

    (4)如要按指定的条件来计数单击 If…按钮，在随即打开的条件对话框中，设置计数条件。单

击 Continue 返回主对话框。单击 OK 执行计数。 

 分类汇总的基本操作 

    数据的分类汇总是指将观测量按若干分组变量(或分类变量)进行分组，对每一组的变量值求其

具有概述性的函数值(统计量值)。例如，将一个工厂的数据资料，按照该工厂的各个部门进行分组，并

以每个部门为单位进行统计汇总。通过分类汇总了解总体内部的结构及其概述特征，如各部分的均值、

总和、百分比等，这项工作也是统计整理中的重要环节。 

    下面以数据文件“机械厂．sav”为例，说明数据分类汇总步骤如下： 

    (1)建立或打开一个数据文件，执行 Data→Aggregate (汇总)命令。打开 Aggregate Data 对

话框。 

    (2)对话框左边为源变量列表栏。右边为 Break Variabules(分组变量)栏，它接纳从源变量列

表框选择的分组变量，分组变量可以是数值型变量也可以是字符型变量。Aggregate Variables (待汇

总的变量)栏对进入此栏的变量值按分组变量进行汇总。 

    从变量列表栏里分别选择分组变量和待汇总变量，移到相应的栏中。 

    当选定汇总变量(必须是数值型变量)移入 Aggregate Variabules 框时，框中出现形如

“###_1=MEAN(###)”的表达式。其中“###”表示选定的来自源变量列表中的待汇总变量名，“ggg 1”

是分类汇总后生成的新文件中的相应变量名，它是用选定汇总变量名的前若干字母跟随下划线“—”及

数字构成。表达式表明变量“ggg_l”的值是汇总变量的分组中各观测量的平均数。这是系统默认的输

出结果。 

    如将文件“机械厂．sav”中的变量“wage”移到 Aggregate Variables 栏时，显示

“wage_l=MEAN(wage)”。如果要改变系统默认的变量名“wage_l”，可以单击 Name & label 按钮，打

开 Name & Labe 对话框示。利用它对选择的汇总变量将出现在新文件中的变量名“wage_l”更名并加注

标签，单击 Continue 返回主对话框。 

    (3)单击 Function (函数) 功能按钮，打开 Aggregate Data：Aggregate Funcdon 对话框，对

这个变量的汇总函数进行设置。 

此对话框的第一部分为 Summary (概括函数)栏。各选项的意义分别如下： 
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Mean of values：算术平均数。    Sum：观测值之和。 

Median：中位数。              Standard deviation：观测值的标准差。 

第二部分为 Specific Values (特殊值)栏。其中有： 

First：第一个观测值。          Minimum：最小观测值。 

Last：最后一个观测值。        Maximum：最大观测值。 

  第三部分为 Number of cases (观测量总数)栏。其中有： 

    Weighted：汇总计算源变量的有效值中各分组变量的观测量数。此选项仅适合加权的数据文件。 

    Weighted missing：汇总计算加权的数据文件中源变量的缺失值数。 

    Unweighted：对未经加权的数据文件，汇总计算源变量的有效观测量中各分组变量的观测量数。 

    Unweighted missing：汇总计算未经加权的数据文件中源变量的缺失值数。 

    第四部分为 Percentage (百分比) 栏。其中有： 

    Above：观测值大于指定值的观测量数占全组观测量总数的百分数。 

    Below：观测值小于指定值的观测量数占全组观测量总数的百分数。 

    选上述两个选项时，在右边被激活的 Value 小框中键入指定值。 

    第五部分为 Fractions (小数) 栏。其中有： 

    Above：观测值大于指定值的观测量数所占的全组观测量总数的比率。 

    Below：观测值小于指定值的观测量数所占的全组观测量总数的比率。 

    选上述两个选项时，在右边被激活的 Value 小框中键入指定值。 

    Inside：观测值界于两个指定值之间的观测量数占全组观测量总数的百分数。 

    Outside：观测值界于两个指定值之外的观测量数占全组观测量总数的百分数。 

    选上述两个选项时，在右边被激活的 Low (下限)和 High (上限)小框中键入指定值。需注意输

入 Low 框中的值必须小于 High 框中的值。 

    函数选择确定后，单击 Continue 返回主对话框。主对话框下面还有： 

    (1)选择选项 Save number of case in break group as variable，将在生成的汇总文件中建

立一个变量保存各分组中的观测量数。同时可以在其后面的矩形栏里为这个变量命名，系统默认的变量

名“N_BREAK”。 

    (2)选择选项 Create new data file (建立新数据文件)，单击 File 按钮，打开 Aggregate Data：

Output File Specification (指明输出文件保存位置) 对话框，指定文件名、路径保存，系统默认的

汇总结果文件名为“AGGR．sav”，需要观看汇总结果，重新打开它即可。 

    (3)选择 Replace working data file (替代工作文件)，则建立的汇总结果文件将替代当前工

作文件显示于数据窗口里。 

    上述各项全部选择完毕，单击主对话框 OK 按钮执行汇总功能。 

 数据分组 

 数据预处理的其他功能 

数据转置 

利用数据的转置功能可以将原数据文件中的行、列进行互换，将观测量转变为变量，将变量转变为

观测量。转置结果系统将创建一个新的数据文件，并且自动地建立新的变量名显示各新变量列。变量转

置的步骤如下： 

    (1)执行 Data→Transpose (转置)命令，打开 Transpose 对话框。 

    (2)从源变量框中选择要进行转置的变量，移入 Variable(s)框中。再从源变量框中选择一个

变量应用它的值作为转置后新变量名，一般选择具有相异观测值的变量或者命名变量。如果选择的是数

值型变量，转置后的变量名以字母 V起头，后面接上原数值。需要指出，对于字符型变量不能实现转置。 

    如果不选择变量移进入 Name Variable 栏，则系统将自动给转置后的新变量赋予 Var001、

Var002、…的变量名。 
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    (3)以上选择确定以后，单击 OK。此时，出现提示信息，提示用户“有些未被选择转置的变量，

其数据会消失”。单击“确定”，随即转置后的新文件将取代原数据文件出现在数据窗口中。如果将原

变量列表中的全部变量都选择进行转置，系统不给出此提示信息。 

加权处理 

权重是统计学里的重要概念之一。所谓权重即同一个观测量值在大量观察和试验中出现的次数，或

频数。在统计计算里常常需要对数据进行加权处理。 

    在记录有大量数据的文件里，可能多次测量到同一观测量值(变量值)。例如同性别、同年龄的

人有许多个，这意味对不同的人，变量 sex 的值、变量 age 的值却是相同的。如果在建立数据文件时能

定义一个频数变量，也称为权变量，用它代表相同观测量出现的次数，在调用统计分析或图形过程时将

可简化计算。 

    SPSS 中使用数据加权处理功能，定义一个权变量后，这个变量的信息将自动地保存于数据文

件中，在以后调用统计分析过程时使用。观测量加权实际上就是为工作文件定义一个权变量。 

    定义频数变量或权变量的具体步骤如下： 

    打开一个数据文件，执行 Data→Weight cases (观测量加权)命令，打开 Weight cases 对话

框。 

对话框中单选项 Do not weight cases (不对观测量加权)为系统默认选项；第二个单选项为 Weight 

cases by (对观测量加权)，选择此项时激活 Frequency variable (频数) 矩形框，从源变量列表中选

择一个加权变量移入此框中，单击 OK，该数据文件的权变量便定义好了。 

    需要指出，一旦为数据文件定义了权变量，则称这个文件为加权数据文件，其中权变量的信息

将一直有效，除非改选用别的变量作为权变量，或者关闭它。此外，如果权变量的值中有 0、负数或缺

失值，它便不能在分析中应用。 

加权数据文件和未经加权的数据文件从数据窗口来看没有任何变化，它们的差异只有在调用统计分

析过程后才可显现出来。例如某校招收的一年级新生 590 人。 

  文件加权前，调用 Analyze 菜单下的 Descriptives (描述统计)命令，计算平均年龄等指标值，

观测量总数为 6，使用简单算术平均公式得到平均年龄 19．5 岁；如果以变量 freq 作为加权变量，观

测量总数为 590，计算平均年龄则使用加权算术平均公式得到 19．42 岁，显然，利用加权变量计算的

结果才是正确的。 

数据拆分 

文件的拆分相当于统计学中的数据分组，即将数据按一个或几个分组变量分成一些供统计分析的分

组。因此文件的拆分并不是将一个文件分成几个文件，文件拆分后启动一个对拆分后的各分组数据进行

统计分析的过程，例如，对拆分后的数据文件进行 Frequncies (频数分析)，分析过程将按照拆分后的

分组进行。如果仅仅直接观察拆分的结果，显示在数据窗口的拆分结果与数据分类整理的结果完全相同。 

  文件拆分的基本操作步骤如下： 

    (1)执行 Data→Split File (文件拆分) 命令，打开 Split File 对话框。 

    根据统计要求从源变量列表框中选择分组变量移送到 Groups Based on (按变量分组)框。这

里最多可以选择 8 个分组变量，它们的作用相当于分类排序中的 By 变量。 

    (2)对话框打开时，系统默认的选项为 Analyze all cases，do not create groups (分析所

有观测量，不进行分组)。 

    为了进行不同分组观测量的分析，选择选项 Compare  groups (比较分组) 或者选项 Organize 

output by groups variables (按分组变量组织输出结果)。当选定分组变量后，选择这两个单选项的

任何一个，执行文件拆分后，再启动一个统计分析过程(例如频数分析)，则输出结果将不相同，前者将

分组变量安置在同一表格里比较层叠输出，后者将按每一个分组变量单独输出。 

    (3)Groups Based on框下有两个单选项，它们只有在选择了Compare groups或Organize output 

by groups variables 后才起作用： 
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Sort the file by grouping variables：按分组变量对文件分类整理。 

File is already sorted：  文件已经被分类整理。 

当数据文件事前没有进行过分类排序，应选择前者，否则选择后者。 

(4)上述各选项确定后，单击 OK 执行拆分即可。 

 

实验三 SPSS 基本统计分析 

1、教学内容提要 

 频数分析（Frequencies 过程） 

描述性分析（Descriptives 过程） 

探索分析（Explore 过程） 

交叉列联表分析(Crosstabs 过程) 

2、教学目标要求 

利用 SPSS 进行基本统计分析 

3、实验步骤 

 定义变量，建立数据文件并输入数据。 

 选择菜单“Analyze→Descriptive Statistics→Frequencies”，选择分析变量，要输出的统

计量以及要绘制的统计图，即完成了频数分析。 

 在 1 的基础上，选择菜单“Analyze→Descriptive Statistics→Descriptives”，选择分析

变量即完成了描述性分析。 

 在 1 的基础上，选择菜单“Analyze→Descriptive Statistics→Explore”，选择 Dependent

变量和 Factor 变量，要输出的统计量以及要绘制的统计图，即完成了探索分析。 

 在 1 的基础上，首先对频数变量的值进行加权处理，再选择菜单“Analyze→Descriptive 

Statistics→Crosstabs”，选择分组变量和分析变量，然后选择卡方检验，定义列联表单元

格中需要计算的指标，即完成了交叉列联表分析。 

[实验软件]  

SPSS For Windows 

[实验示范讲解]  

[实验独立操作] 

 

实验四 SPSS 的参数检验 

1、教学内容提要 

 描述统计(Means 过程) 

 单样本 T 检验（One-Sample T Test 过程） 

 两独立样本 T 检验（Independent-Samples T Test 过程） 

 成对样本 T检验（Paired-Samples T Test 过程） 

2、教学目标要求 

利用 SPSS 进行单样本、两独立样本以及成对样本的均值检验。 

[实验步骤] 

 定义变量，建立数据文件并输入数据。 

 选择菜单“Analyze→Compare Means→Means”,选择 Dependent 变量和 Independent 变量，设

置输出的描述统计量，即完成了描述统计。 

 在 1 的基础上，选择菜单“Analyze→Compare Means→One-Sample T Test”，选择 Test 变

量并输入已知的均值，即完成了单样本 T 检验。 

 在 1 的基础上，选择菜单“Analyze→Compare Means→Independent-samples T Test”，选择
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Test 变量和分组变量，即完成了两独立样本 T检验。 

 在 1 的基础上，选择菜单“Analyze→Compare Means→Paired-samples T Test”项，选择分

析变量，即完成了成对样本 T 检验。 

[实验软件]  

SPSS For Windows 

[实验示范讲解]  

[实验独立操作] 

实验五 SPSS 的相关分析 

1、教学内容提要 

 两变量的相关分析（Bivariate 过程） 

 绘制散点图 

 计算相关系数 

 偏相关分析(Partial 过程) 

2、教学目标要求 

利用 spss 软件进行相关性分析（二元定序变量的相关分析、偏相关分析、距离相关分析）[实验原

理]  

 [实验步骤] 

 定义变量，建立数据文件并输入数据。 

 选择菜单“Analyze→Correlate→Bivariate”，选择要进行相关分析的两个变量，并选择

Pearson 相关系数（r）,然后选择对相关系数进行双侧检验，选择要输出的统计量，即完成了

两变量的相关分析。 

 在 1 的基础上，选择菜单“Analyze→Correlate→Partial”，选择控制变量以及要进行相关

分析的两个变量，然后选择对相关系数进行双侧检验，选择要输出的统计量，即完成了偏相关

分析。 

 

实验六 SPSS 的回归分析 

1、教学内容提要  

线性回归分析(Linear 过程) 

2、教学目标要求 

利用 spss 软件进行线性回归分析（一元线形回归）[实验原理]  

 3、[实验步骤] 

在 1 的基础上，选择菜单“Analyze→Regression→Linear”，分别选择自变量、因变量及 Enter

方法，然后选择是否作变量的描述性统计、回归方程应变量的可信区间估计等分析，即完成了线性回归

分析。 

在 1 的基础上，选择菜单“Analyze→Regression→Curve Estimation”，分别选择自变量和因变

量，并选择要拟合的模型，选中“Plot models”复选框以输出曲线拟合图，选中 “Predicted value”

复选框，在原始数据文件中保存根据对数方程求出的预测值，即完成了曲线回归分析。 

[实验软件]  

SPSS For Windows 

[实验示范讲解]  

[实验独立操作] 

 

三、考核方式与成绩评定 
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1、考核方式 

2、成绩评定 

四、主要仪器设备及实验材料 

项目编号 实验项目名称 
主要仪器设备 

及台（套）数 
实验材料 备注 

1202010220401 
SPSS 数据文件的建立和管

理 
计算机 SPSS 统计软件  

1202010220402 SPSS 数据的预处理 计算机 SPSS 统计软件  

1202010220403 SPSS 基本统计分析 计算机 SPSS 统计软件  

1202010220404 SPSS 的参数检验 计算机 SPSS 统计软件  

1202010220405 SPSS 的相关分析 计算机 SPSS 统计软件  

1202010220406 SPSS 的线性回归分析 计算机 SPSS 统计软件  

五、教材及参考书 

教  材：《统计分析 SPSS 的应用》，薛薇主编著，中国人民大学（第四版），2014 年 

参考书：1、《SPSS 统计分析实例精选》，蔡建琼等主编，清华大学出版社，2006 年出版 

2、《SPSS for windows 应用》，卢文岱主编，电子工业出版社，2002 年第 2 版 

3、《SPSS 统计应用实务》，吴明隆主编，科学出版社，2003 年第 1 版 

4、张文彤、 邝春伟.高等学校教材:SPSS 统计分析基础教程(第 2 版).高等教育出版

社 .2011.11  

六、教改说明及其他 

 

 

大 纲 制 定 人：  郭 瑞  

大 纲 审 定 人：   何 叶 荣  

制 定 时 间：  2 0 1 6 年 5 月  

（此处加盖院系公章）                     
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生产现场管理实验课程教学大纲 

课程编号：12120202501                       课程属性： 必修     

实验学时： 18                      实验个数：9   

学    分：2                        开课学期：5      

适用专业： 市场营销           

课程简介：    生产现场管理是市场营销专业学生学习的重要课程之一。该门课程主要面向生产制

造现场的维持与改善、优化与设计，它既具有高度的专业理论综合性，又具有很强的实用

操作性，是一门研究生产现场实际工作问题和规律，并探讨一般解决方法的科学。通过成

功与失败的网上创业案例的讨论与分析，增强学生对创业的感性和理性认识；通过模拟软

件实验教学和创业计划书的撰写培养学生创业动作能力。 

通过本课程的学习，使学生了解现场管理的任务、地位和作用，熟悉现场管理的基

本概念和基本思想；重点掌握现场管理与改善的主要观念；掌握现场处理问题的一般思

路和方法，并能在实践中灵活运用和推行；初步具有从事现场实际工作的能力，以及分

析问题和解决问题的能力。 

本课程的总体框架，按照“现场管理的金科玉律”展开。虽然要求学生具有较深厚

的专业理论基础，但重在面向操作层面讨论解决现场实际问题。避免在深层理论方面过

多的纠缠，侧重介绍常识性、低成本、低风险的现场管理方法。 

项目编号 实验项目名称 
实验 

类型 

开出 

要求 

学时 

分配 

每组 

人数 

121202025011 生产现场管理的职责与使命 综合 必修 2  

121202025012 现场管理的金科玉律（现场管理之屋） 综合 必修 2  

121202025013 5S 管理 综合 必修 2  

121202025014 现场改善手法 综合 必修 2  

121202025015 现场品质管理 综合 必修 2  

121202025016 现场成本控制 综合 必修 2  

121202025017 设备管理 综合 必修 2  

121202025018 柔性生产方式 综合 必修 2  

121202025019                 案例分析及基本要求 综合 必修 2  

学时总计 18 

二、实践内容及教学要求 

实验项目 1：生产现场管理的职责与使命 

教学内容 

1、 制造业生产管理竞争重点分析 
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立足企业生产现场、全面提升生产力。生产活动与企业的经营目标有密切的关联。企业生产现场如

果不够健壮，将无法在市场中取得竞争优势。虽然卓越的研究开发可使新产品进入市场，是企业竞争最

重要的武器，但仍需依赖卓越的生产活动才能立足于市场，现在竞赛的重心在于生产过程改善。 

2、现场管理与改善 

（1）现场 

（2）现场管理注重“改善” 

（3）改善是一种低风险管理方式 

3、现场改善的观念 

（1） 现场中心主义 

（2） 维持与改进标准 

（3） 过程与结果 

（4） 质量第一 

（5） 用数据说话 

（6） 下一道工序就是顾客 

（7） 遵循 PDCA 循环/SDCA 循环 

4、造就一个优秀的团队 

教学目标 

了解生产现场管理的地位和作用，掌握现场管理的基本概念，重点掌握生产现场改善的主要观念，

理解以简单的常识处理复杂问题的道理。 

实验项目 2：现场管理的金科玉律（现场管理之屋） 

教学内容 

1、 三大目标（QCD） 

（1）质量 

（2）成本 

（3）交货期 

2、 三现主义 

（1）现场 

（2）现物 

（3）现实 

3、 三项基础——现场管理体系 

（1）正确的现场管理意识 
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（2）5S 管理 

（3）现场管理支柱 

现场品质管理；现场成本控制；现场人力资源系统；现场设备管理；柔性生产 

教学目标 

这部分是整个课程内容纲要，使学生从总体上了解现场管理知识基本框架，掌握金科玉律的基本内

容，重点掌握“三三三制”——三大目标、三现主义和三项基础。 

实验项目 3：5S 管理 

教学内容 

1、5S——现场管理之基石，人员品质提升之利器 

2、 5S 基础 

（1） 整理（Seiri， Sort） 

（2） 整顿（Seiton,  Straighten） 

（3） 清扫（Seiso， Scrub） 

（4） 清洁（Seiketsu， Systematize） 

（5） 素养（Shitsuke， Standardize） 

3、5S 活动推行要领步骤 

5S 每项管理活动的推行，可按照以下层次展开讨论： 

（1）定义 

（2）目的 

（3）推行要领 

（4）推行步骤 

（5）具体案例 

4、5S 活动实施技巧 

（1）红牌作战 

（2）定置管理 

（3）目视管理及看板管理 

（4）颜色管理等 

5、5S 的延伸 

（1）TPM 的开展 

（2）QCC 的开展 
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6、企业 5S 推行案例研讨 

教学目标 

推行 5S 管理活动是课程重点内容之一。了解 5S 是现场管理与改善的基础，掌握 5S 的内涵，重点

掌握 5S 推行要领及实施技巧，学会处理现场事务及活动组织的能力。 

实验项目 4：现场改善手法 

教学内容 

1、改善的意识 

2、现场改善的内容 

3、 常用现场改善手法 

（1）问题解决七步法 

（2）问题解决七步法案例 

（3）作业改善四阶法 

（4）价值分析手法 

  4、如何营造现场改善气氛 

教学目标 

理解现场改善的意识，熟悉现场改善的内容，掌握现场改善的手法，并能解决实际问题，学会营造

现场改善的气氛。 

实验项目 5：现场品质管理 

教学内容 

1、品质管理的理念 

 （1）现代品质的要求 

 （2）什么是品质管理 

2、现代品质管理体系（MQM） 

（1）ISO9000 系列与 MQM 

（2）MQM 体系的构成 

（3）MQM 体系说明 

（4）MQM 体系的推行 

3、常用品管问题的解决手法 

  （1）检查表的使用 

  （2）特性要因图 



 
 

  37

  （3）柏拉图 

  （4）分析图表 

  （5）直方图 

  （6）工程能力图 

  （7）管理图 

  （8）散布图 

  （9）层别法 

  （10）交换实验法 

  （11）抽样检验 

  （12）品质成本 

4、品质保证的组织架构  

教学目标 

了解现场质量管理的基本知识，掌握质量控制的常用的手法，了解现代品质管理体系的 3 大系统：

全体系统、工序保证系统、检查系统的共 28 个项目，全面及详细地从工厂全方位实施有效的品质管理

及改善。重点掌握现场品质管理的基本活动，学会应用常识性、低成本的方法有效地检查、控制现场制

造过程的质量问题。。 

实验项目 6：现场成本控制 

教学内容 

1、基本思想 

2、落实检查 5S 活动 

3、分析消除现场 7 类浪费 

（1）过量生产浪费 

（2）库存浪费 

（3）不良品浪费 

（4）动作浪费 

（5）人员利用浪费 

（6）等待时间浪费 

（7）搬运浪费 

4、JIT 彻底排除浪费的三大基本方法 

（1）适时适量生产 

（2）弹性配置作业人数 
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（3）质量保证 

教学目标 

使学生了解现场成本问题不是核算出来的，而是在设计、制造过程中形成的，了解现场成本控制的

基本思想，重点掌握现场的 7 类浪费及消除浪费的基本方法，学会现场观察问题并提出改善措施的能力。

实验项目 7：设备管理 

教学内容 

1、设备是企业的核心  

2、 正确的设备维护观念 

3、 设备现场管理体系 

4、 设备运行的指标体系 

教学目标 

了解设备及安全管理的地位作用，掌握 TPM 的核心理念、方针和目标，重点掌握设备现场管理的内

容及激励约束机制，了解现场事故的原因和预防学会设备和安全管理的一般方法。 

实验项目 8：柔性生产方式 

教学内容 

1、 生产方式常用基本概念 

2、 自动化流水线生产的优劣点分析 

3、 柔性生产方式的特性 

4、 柔性生产方式的具体形式 

5、 选择不同生产方式的基本思路 

实验项目 9：案例分析及基本要求 

案例分析是生产现场管理课程必要的课堂实践活动。主要培养学生能灵活运用现场管理的一些常识

性、低成本、低风险的方法，按照现场现物的原则，去发现现场中存在的问题，并学会分析问题和解决

问题。要求学生独立思考，认真研究，写出案例分析报告，以不同方式进行互动交流讨论。教师在整个

过程中要善于启发引导学生积极、主动的思考问题，并及时做好总结归纳，鼓励创造性思维。 

三、考核方式与成绩评定 

1、考核方式：考查 

2、成绩评定：实验过程表现和考勤占 30%，实验报告 30%，期末理论考试占 40% 

 

 

 

 



 
 

  39

 

 

四、主要仪器设备及实验材料 

项目编号 实验项目名称 
主要仪器设备 

及台（套）数 
实验材料 备注 

121202025011  生产现场管理的职责与使命 计算机 111 台和服务器 1 台 实验报告等  

121202025012  现场管理的金科玉律（现场

管理之屋） 
计算机 111 台和服务器 1 台 实验报告等  

121202025013  5S 管理  计算机 111 台和服务器 1 台 实验报告等  

121202025014  现场改善手法  计算机 111 台和服务器 1 台 实验报告等  

121202025015 现场品质管理  计算机 111 台和服务器 1 台 实验报告等  

121202025016  现场成本控制  计算机 111 台和服务器 1 台 实验报告等  

121202025017  设备管理  计算机 111 台和服务器 1 台 实验报告等  

121202025018  柔性生产方式  计算机 111 台和服务器 1 台 实验报告等  

121202025019  案例分析及基本要求  计算机 111 台和服务器 1 台 实验报告等  

五、教材及参考书 

教材：现场管理实务（上、下），肖智军等编著，广东经济出版社，2011 年版 

 参考书： 

1、5S 活动推行实务，肖智军著，广东经济出版社，2009 年版 

2、现场管理与改善，（日）今井正明著、华 经译，机械工业出版社，2010 年出版。 

    3、现代企业现场管理行为，李景元著，企业管理出版社，2011 年出版。 

    4、如何推行 5S，孙少雄著，厦门大学出版社，2011 年出版。 

    5、物流管理（供应连管理的一体化），（美）唐纳德 J.鲍尔索克斯、戴维 J.克劳斯著，机

械工业出版社，2012 年出版 

6、 品质管理实务，肖智军著，广东经济出版社，2011 年版 

7、 目标——简单而有效的常识管理，高德拉特著，上海三联书店，2012 年印刷 

六、教改说明及其他 

大 纲 制 定 人：  聂 梓  

大 纲 审 定 人：   何 叶 荣  

制 定 时 间：  2 0 1 6 年 5 月  

（此处加盖院系公章）                     
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客户关系管理实验课程教学大纲 

课程编号：12120202407          课程属性：专业方向课 

学    时：18                   学    分：1    

开课学期：5                    先修课程：管理学、销售管理等 

适用专业：市场营销  

课程简介：  

客户关系管理一门实践性较强的学科。通过实验教学环节，对学生进行实践技能和科

学研究方法的训练，巩固其在课堂上所学书本知识，通过模拟操作使学生对客户关系管理

的实务有深刻的感性认识。通过训练使学生达到实际操作人员的基本技能。从客户关系管

理的应用功能出发，以客户关系管理各参与主体的运作为表现，使学生全面掌握客户关系

管理的用途与操作技能。 

一、实验项目设置及学时分配 

项目编号 实验项目名称 
实验 

类型 

开出 

要求 

学时 

分配 

1212020240201 了解 CRM 系统，系统基础设置 验证性 必做 6 

1212020240202 客户管理  验证性 必做 4 

1212020240203 销售管理  验证性 必做 4 

1212020240204 营销业务管理  验证性 必做 4 

1212020240205 客户管理相关统计分析决策  验证性 选作 0 

学时总计 18 

二、实验内容及教学要求 

实验项目 1：了解 CRM 系统，系统基础设置 

1、教学内容 

（1）演示 CRM 系统，练习其功能。 

（2）登录客户管理系统，并进行基础资料设置、系统设置、初始化数据库、数据库备份与恢复、操

作员管理、商品管理与员工提成设置。 

2、教学目标 

（1）了解 CRM 概况； 

（2）对 CRM 软件进行初始化处理和基础设置。  

实验项目 2：客户管理 
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1、教学内容 

包括客户资料管理、客户联系管理、客户跟进管理、客户提醒管理、客户回款管理、流失客户管

理、文档合同管理、客户信息管理。 

2、教学目标 

掌握对客户管理的基本方法与技巧 

实验项目 3：销售管理 

1、教学内容 

（1）完成销售任务的信息录入、维护、关闭和查询功能。完成对市场任务相关的日程、进程、产

品、附件等信息的编辑。 

（2）通过销售机会管理可以维护销售机会列表，编辑销售机会，生成销售任务，查看销售机会中

客户的信息。 

（3）通过报价管理，主要完成对客户所作报价单的定义、维护和查询功能，并将相应的报价单的

信息携带进销售订单。 

2、教学目标 

通过对销售系统进行基础资料的设置，包括：权限控制、审批流程、销售主页设置、销售方法定义、

商机配置、系统参数的设定等，来实现系统正常的销售管理活动。 

实验项目 4：营销业务管理 

1、教学内容 

（1）线索管理包括  添加线索、浏览线索、修改线索信息、向他人移交线索、删除线索、将线索升级

为新客户和联系人等。 

（2）客户、联系人操作主要在 CRM 客户关系管理系统中，客户管理、联系人管理中完成。 

（3）联系人管理主要提供了添加、浏览、移交、删除、报表等功能；客户管理主要提供了客户的添

加、新建、报表等功能。二者都详细地记录了联系人、客户的详细信息，还提供了任务等功能。 

（4）在销售机会管理的过程中，可以添加销售机会，在详细的页面浏览机会，对机会进行统计和报

告。 

（5）另外，你也可以对成功把握的销售机会进行评估等。 

（6）在竞争对手的主页可以浏览对手，添加对手，对对手做报告等。 

2、教学目标 

通过本课程实验，掌握对客户管理软件中销售业务管理的基本方法与技巧。 
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实验项目 5：客户管理相关统计分析决策 

1、教学内容 

对客户、合作伙伴、竞争对手、市场、销售、服务、产品及员工的各种信息进行统计和分析，为企

业发展提供决策依据。为形象地表现分析的结果。 

2、教学目标 

（1）如何对客户、合作伙伴、竞争对手、市场、销售、服务、产品及员工的各种信息数据进行统

计和分析； 

（2）如何对分析出来的数据进行下一步的工作安排。 

三、考核方式及要求 

本课程为考试课，实验课程考试方法由上机操作和实验报告两大块组成；评分标准：上机操作占

70%，实验报告成绩占 30%。 

四、主要仪器设备及实验材料 

项目编号 实验项目名称 
主要仪器设备 

及台（套）数 
实验材料 备注 

1212020240201 
了解 CRM 系统，系统基础设

置 
联网计算机及相关软件 计算机耗材  

1212020240202 客户管理  联网计算机及相关软件 计算机耗材  

1212020240203 销售管理  联网计算机及相关软件 计算机耗材  

1212020240204 营销业务管理  联网计算机及相关软件 计算机耗材  

1212020240205 
客户管理相关统计分析决

策 
联网计算机及相关软件 计算机耗材  

五、教材及参考书 

1、《客户关系管理—客户关系的建立和维护（第 3版）》,清华大学出版社,苏朝晖编著,2014

年 第 3 版 

 

六、教改说明及其他 

 

 

大纲制定人：   霍圣年  

大纲审定人：   
何 叶 荣  

制 定 时 间：  
20 1 6 年 5 月  
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财务报表分析实验教学大纲 

课程编号： 12120202505             课程属性：  必修     

实验学时：   18                    实验个数：    7 

学    分：   1                     开课学期：    7    

适用专业：   市场营　（卓越）         

课程简介：《财务报表分析》是经济管理类市场营销专业的必修课程。通过本课程的学习，使学生

能够全面深入地掌握财务报表分析的知识，具有较强的财务报表分析能力；能够根据用户的信息要求，

结合实际情况，进行财务报表分析工作。本课程教学目的是掌握基本的分析原理和方法；能够运用这些

原理和方法对财务报表及企业披露的其他信息进行深入分析；注重会计规范内容的学习。 

一、实验项目设置及学时分配 

项目编号 实验项目名称 
实验 

类型 

开出 

要求 

学时 

分配 

每组 

人数 

1212020250501 资产负债表水平分析、趋势分析和结构分析 综合 必修 2 1 

1212020250502 资产负债表的比率分析 设计 必修 2 1 

1212020250503 利润表水平和结构分析 综合 必修 2 1 

1212020250504 利润表的比率分析 综合 必修 2 1 

1212020250505 现金流量表分析 设计 必修 3 1 

1212020250506 所有者权益变动表分析 设计 必修 3 1 

1212020250507 财务报表综合分析 综合 必修 4 1 

学时总计 18 

二、实验内容及教学要求 

实验项目 1：资产负债表水平分析、趋势分析和结构分析 

1、教学内容提要 

搜集一个上市公司 2013—2015 年的资产负债表，分别对 2013-2014、2014-2015 期间的有关项目的

变化情况进行考察，分析资产、负债和所有者权益的变化情况及其变动原因；考察该公司的资产、负债

和所有者权益的变化趋势；制作资产负债表百分比分析，结合行业资料，分析其资产结构和资本结构的

合理性；分析企业战略对资产负债表的影响。 

2、教学目标要求 

深入理解资产负债表的结构与特征；掌握资产负债表水平分析和结构分析方法；理解会计政策对资

产负债表项目的影响 

实验项目 2：资产负债表的比率分析 

1、教学内容提要 

根据一个上市公司 2013—2015 年的资产负债表，分别对 2013、2014、2015 年度的偿债比率进行计

算；根据计算结果，结合行业资料以及企业的历史资料，分析企业的偿债能力。 

2、教学目标要求 

  掌握短期偿债能力分析方法与长期偿债能力分析方法 
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 实验项目 3：利润表水平和结构分析 

1、教学内容提要 

搜集一个上市公司 2013—2015 年的利润表，分别对 2013-2014、2014-2015 期间的有关项目的变化

情况进行考察，分析收入、成本费用和利润的变化情况及其变动原因；考察该公司的收入、成本费用和

利润的变化趋势；对收入结构、成本费用结构和利润结构进行分析；分析企业战略对利润表的影响； 

2、教学目标要求 

深入理解利润表的结构与特征；掌握利润表水平分析和结构分析方法；理解会计政策对利润的影响。 

实验项目 4：利润表的比率分析 

1、教学内容提要 

根据一个上市公司 2013—2015 年的利润表，分别对 2013、2014、2015 年利润表的有关项目的变化

情况进行考察，分析收入、成本费用和利润的变化情况及其变动原因；根据计算结果，结合行业资料以

及企业的历史资料，分析企业的盈利能力及其趋势。 

2、教学目标要求 

  掌握盈利能力分析方法 

实验项目 5：现金流量表分析 

1、教学内容提要 

搜集一个上市公司 2013—2015 年的现金流量表，分别对 2013-2014、2014-2015 期间的有关项目的

变化情况进行考察，分析经营活动现金流量、投资活动现金流量和筹资活动现金流量的变化情况及其变

动原因；考察该公司经营活动现金流量、投资活动现金流量和筹资活动现金流量的变化趋势；对现金流

量结构进行分析；根据现金流量表，结合其他报表资料，分析企业的支付能力、盈利质量等指标；分析

企业战略对现金流量表的影响。 

2、教学目标要求 

  深入理解现金流量表的结构与特征；深刻认识企业三种活动的分类及其本质含义；掌握现金流量的

比率分析方法；掌握现金流量表水平分析和结构分析方法。 

实验项目 6：所有者权益变动表分析 

1、教学内容提要 

  搜集一个上市公司 2013—2015 年的所有者权益变动表，分别对 2013-2014、2014-2015 期间的有关

项目的变化情况进行考察，分析股本、资本公积、盈余公积和未分配利润的变化情况及其变动原因；考

察该公司所有者权益的变化趋势；对所有者权益变动表进行水平和结构分析； 

2、教学目标要求 

  深入理解所有者权益变动表的结构与特征；掌握所有者权益变动表的水平分析方法；掌握所有者权

益变动表结构分析方法。 

实验项目 7：财务报表综合分析 

1、教学内容提要 

  搜集一个上市公司 2010—2012 年的年度报告，根据财务报告的有关数据，对该公司的营运能力指

标和成长能力指标进行计算；结合行业资料以及竞争对手的资料，对该公司的营运能力和偿债能力进行

评价；运用杜邦分析体系对 2011 年和 2012 年的盈利情况进行分析。并探寻提高净资产收益率的途径和

措施；运用财务比率综合评分表分析方法对该公司的财务状况进行评价。 

2、教学目标要求 

  深入理解三张报表之间的内在关系；掌握营运能力分析常用的财务比率；掌握成长能力分析的指标
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和方法；实验掌握杜邦综合分析方法； 

三、考核方式与成绩评定 

1、考核方式 

为了加强学生对实验教学的重视程度，促进实验教学质量不断提高，本课程实验教学要进行考核并

评定等级。根据学生的现场实验结果和实验报告综合决定该学生的实验成绩。每个实验，实验报告占

30%，实际操作 40%，总结报告 30%，根据学生完成的各个实验的成绩，算出其平均分数，最后得出该学

生的实验成绩。 

2、成绩评定 

实验成绩分：优（90—100 分）、良（80—89 分）、中（70—79 分）、及格（60—69 分）、不及

格（60 分以下）五级。实验成绩计入课程总成绩，实验成绩不合格者不能参加所属理论课程考试。实

验缺课学时达 1/4 以上者，不得参加该门课程的考核。实验成绩的评分要力求作到认真、客观、公正。

考核结果要记录存挡。 

四、主要仪器设备及实验材料 

项目编号 实验项目名称 
主要仪器设备 

及台（套）数 
实验材料 

备

注 

1212020250501 
资产负债表水平分析、趋势

分析和结构分析 
投影仪、电脑（各一台） 计算器、账簿、凭证  

1212020250502 资产负债表的比率分析 投影仪、电脑（各一台） 计算器、账簿、凭证  

1212020250503 利润表水平和结构分析 投影仪、电脑（各一台） 计算器、账簿、凭证  

1212020250504 利润表的比率分析 投影仪、电脑（各一台） 计算器、账簿、凭证  

1212020250505 现金流量表分析 投影仪、电脑（各一台） 计算器、账簿、凭证  

1212020250506 所有者权益变动表分析 投影仪、电脑（各一台） 计算器、账簿、凭证  

1212020250507 财务报表综合分析 投影仪、电脑（各一台） 计算器、账簿、凭证  

五、教材及参考书 

教  材：《财务报表分析》（第二版），王化成编著，北京大学出版社，2014 年。  

参考书：《财务报表分析》（第二版），岳红编著，中国人民大学出版社，2014 年。 

《财务报表分析》（第三版），钱爱民编著，中国人民大学出版社，2014 年。  

六、教改说明及其他 

无 

大 纲 制 定 人：  裴 飞 云  

大 纲 审 定 人：   何 叶 荣  

制 定 时 间：  2 0 1 6 年 5 月  

（此处加盖院系公章）                    
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供应链管理实验教学大纲 

课程编号： 12120202405                   课程属性： 专业选修课     

实验学时： 18                            实验个数：4    

学    分：1                              开课学期： 7      

适用专业：市场营销            

课程简介：  

《供应链管理》系统建立了一个平台，引导学生在社会化大生产中，利用流通组织形式和市场

营销方式，将电子商务、市场营销、物流管理等专业理论知识融入产品生产和流通过程所涉及的原

材料供应商、生产商、批发商、零售商以及最终消费者的活动中，组成跨地区供需网络。让学生在

商品供给的链条中，参于企业间商品流通过程中发生的各种管理活动，通过信息的共有化、需求预

测的共有化等等来实现物流机能的分担，实现商品流通全过程的效率最大化分析。让学生学习利用

管理的计划、组织、指挥、协调和激励职能，对产品生产和流通过程中各环节所涉及的物流、信息

流、资金流、价值流以及业务流进行的合理调控，以期达到最佳组合，发挥最大效率，迅速以最小

的成本为客户提供具有较大附加值的信息。 

一、实验项目设置及学时分配 

项目编号 实验项目名称 
实验 

类型 

开出 

要求 

学时 

分配 

每组 

人数 

1212020240501 供应链系统建立 综合性 必做 4 3 

1212020240502 供应商评价系统构建 综合性 必做 4 3 

1212020240503 供应链协调效应实验 综合性 必做 4 3 

1212020240504 供应链合作方案优化 综合性 必做 6 3 

学时总计 18 

二、实验内容及教学要求 

实验项目 1：供应链系统建立 

1、教学内容提要 

系统学习系统管理和基础设置的主要内容与操作方法。要求掌握系统管理中设置操作员、建

立帐套和设置操作员权限的方法，掌握基础设置的内容与方法，掌握帐套输出和引入的方法。 

2、教学目标要求 

（1）掌握增加操作员的方法 

（2）掌握建立核算单位帐套的方法 

（3）掌握对操作员进行授权的方法 

（4）掌握启用供应链及其相关子系统的方法 

（5）掌握帐套备份的方法 

  实验项目 2：供应商评价系统构建 
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1、教学内容提要 

模拟企业采购助理，搜集供应商信息、选择供应商、选择出合适的供应商。 

2、教学目标要求 

掌握评价系统的构建方法；熟悉运用互联网和所学采购知识进行“搜集供应商信息”和“选择

供应商”两个环节的练习，选择出合适的供应商。 

        实验项目 3：供应链协调效应实验 

1、教学内容提要 

进行“啤酒订购试验”，分角色模拟供应链的订货过程11周以上、按要求作记录、对订货结果

进行分析。 

2、教学目标要求 

（1）了解供应链上的不协调现象 

（2）掌握供应链上不协调现象产生的原因 

（3）了解供应链不协调现象的危害 

（4）掌握缓解供应链上不协调现象的方法 

实验项目 4：供应链合作方案优化 

1、教学内容提要 

分析企业现有的供应链管理运作流程、优化企业的供应链运作流程、方案文档撰写并汇报。 

2、教学目标要求 

在学习完供应链管理相关知识后让学生进行的更高层次的综合能力训练，使学生掌握运用所学

理论知识和技能，分析、研究和解决企业供应链管理实际问题。通过撰写“某商品供应链管理改善

方案”使学生了解、熟悉和掌握所学知识，学会如何检索和分析处理数数据资料，提高学生在实际

工作中发现问题、分析问题和解决问题的能力。  通过以组为单位进行实地调查获取资料的方式，

培养学生的团队合作精神以及人际交往与沟通能力。   

三、考核方式与成绩评定 

1、考核方式：考核方式为考查。 

2、成绩评定： 

（1）课堂综合表现，占30分，包括课堂中是否认真填写各类练习以及是否积极参与讨论、积

极发表意见、回答讲师提问等方面； 

（2）课后实验报告和实战操作成绩，占70分，课后实验报告要求4000字左右，根据综合演练

的情况完成实习报告；实战操作成绩根据每个学生的实际操作成绩打分。 

四、主要仪器设备及实验材料 

项目编号 实验项目名称 
主要仪器设备 

及台（套）数 
实验材料 备注 

1212020240501 供应链系统建立 联网计算机及 ERP 系统 计算机耗材  

1212020240502 供应商评价系统构建 联网计算机及 ERP 系统 计算机耗材  

1212020240503 供应链协调效应实验 联网计算机及 ERP 系统 计算机耗材  

1212020240504 供应链合作方案优化 联网计算机及 ERP 系统 计算机耗材  
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五、教材及参考书 

教  材：《ERP 系统原理和实施  》，闪四清编著，清华大学出版社，2013 年。 

参考书：《ERP 与企业管理——理论、方法、系统》，周玉清编著，清华大学出版社，2012 年。 

《用友 ERP 供应链管理系统实验教程》（第 2 版），赵建新编著，清华大学出版社，2012

年。 

六、教改说明及其他 

 

 

大 纲 制 定 人：  沈 晓 霞  

大 纲 审 定 人：   何 叶 荣  

制 定 时 间：  2 0 1 6 年 5 月  
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企业供应链模拟实验课程教学大纲 

课程编号：12120202601               课程属性：实验实训课       

学    时： 36                       学    分： 2   

开课学期：4                         适用专业：市场营销      

先修课程：管理学、市场营销、市场营销调研、物流管理概论、运筹学等      

课程简介：  

《企业供应链模拟》系统建立了一个平台，引导学生在社会化大生产中，利用流通组

织形式和市场营销方式，将电子商务、市场营销、物流管理等专业理论知识融入产品生产

和流通过程所涉及的原材料供应商、生产商、批发商、零售商以及最终消费者的活动中，

组成跨地区供需网络。让学生在商品供给的链条中，参于企业间商品流通过程中发生的各

种管理活动，通过信息的共有化、需求预测的共有化等等来实现物流机能的分担，实现商

品流通全过程的效率最大化分析。让学生学习利用管理的计划、组织、指挥、协调和激励

职能，对产品生产和流通过程中各环节所涉及的物流、信息流、资金流、价值流以及业务

流进行的合理调控，以期达到最佳组合，发挥最大效率，迅速以最小的成本为客户提供具

有较大附加值的信息。 

一、实验项目设置及学时分配 

项目编号 实验项目名称 
实验 

类型 

开出 

要求 

学时 

分配 

1212020260101 交易中心注册 综合性 必做 4 

1212020260102 认证中心信息完善 综合性 必做 4 

1212020260103 调度中心管理 综合性 必做 4 

1212020260104 仓储中心管理 综合性 必做 4 

1212020260105 运输中心操作 综合性 必做 4 

1212020260106 货托中心业务处理 综合性 必做 4 

1212020260107 结算中心数据处理 综合性 必做 4 

1212020260108 财务统计业务操作 综合性 必做 4 

1212020260109                         客户管理系统运用 综合性 必做 4 

学时总计 36 

二、实验内容及教学要求 
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实验项目 1：交易中心注册 

1、 教学内容 

熟悉交易中心界面，做好会员申请、会员服务和会员管理等工作。 

2、教学目标 

（1）掌握注册申请会员； 

（2）了解会员信息修改、更改密码、查看订单； 

（3）学会发布信息供求、企业管理、产品管理、应收帐管理、应付帐管理。 

实验项目 2：认证中心信息完善 

1、教学内容 

在电子商务系统中，所有实体的证书都是由证书授权中心即 CA 中心分发并签名的。一个完整、安

全的电子商务系统必须建立起一个完整、合理的 CA 体系。CA 体系由证书审批部门和证书操作部门组成。 

2、教学目标 

（1）能正确填写相关信息，完成会员注册； 

（2）掌握实现企业身份认证和企业 SET 认证的具体操作； 

（3）掌握认证管理的具体功能：对认证中心会员的管理、身份认证的审批与管理、SET 认证的审

批与管理。 

实验项目 3：调度中心管理 

1、教学内容 

调度中心是配送系统的中心机构，是发送指令的单位，控制仓储中心、运输中心等。配货管理模块

完成从客户申配受理、配送作业生成、一直到实际配送出库的一系列管理功能，满足配送业务的需要，

保障配送业务有序、高效地进行。 

2、教学目标 

（1）掌握备货、理货和送货三个基本的配送工作环节； 

（2）掌握调度管理的具体工作：通知仓储中心进行配货、核算运输费用、通知运输中心送货等。 

实验项目 4：仓储中心管理 

1、 教学内容 

实现仓库网上管理，包括提供报警机制，对仓库中的异常情况自动报警，对库存的调整、内拨、盘

点、退货、调换、包装、报废处理等进行管理，还有查询货位（箱位）的占用和剩余可使用情况。 

仓储中心包括有货源管理、库存管理和包装货物。 

2、 教学目标 

（1）了解货源管理如何采用商家登记代理的方式； 

（2）掌握库存管理的六项基本工作； 

（3）了解包装货物应如何收到调度中心包装通知、配货管理。 

实验项目 5：运输中心操作 

1、 教学内容 

负责接受调度中心的运输指令，按照跟踪号的配送地址进行送货。 其操作如下：先是接收调度中

心发出的运输通知，然后调配车辆运输里去进行装运。 

2、教学目标 
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（1）掌握运输员具体怎样负责接受调度中心的运输指令，按照跟踪号的配送地址进行送货； 

（2）了解驾驶员管理、车辆管理和运输任务调度； 

（3）了解运输方式的选择前提。 

实验项目 6：货托中心业务处理 

1、教学内容 

当配送定单的运输方式为铁路运输、水路运输和航空运输时，配送中心由于硬件条件的约束，需要

委托第三方的运输机构来完成运输任务，也必须支付委托运输费。 

2、教学目标 

（1）掌握货物托运委托书确认流程； 

（2）了解业务办理的状态跟踪。 

实验项目 7：结算中心数据处理 

1、教学内容 

结算中心设有以下功能：企业开户、更新密码、忘记密码、存款、取款、合同结帐、配送结算、货

托结算、明细帐查询和余额查询。 

2、教学目标 

（1）掌握企业开户、更新密码、忘记密码是的具体处理工作； 

（2）掌握存款、取款、合同结帐、配送结算、货托结算； 

（3）了解明细帐查询和余额查询。 

实验项目 8：财务统计业务操作 

1、教学内容 

这里所说的财务管理不仅仅是指日常的、常规性的财务管理工作，更主要的是物流成本的分析、控

制等较高层次的管理工作。 

2、教学目标 

（1）学会选择年、月、日对该日的所有财务出入帐进行统计； 

（2）学会对配送中心的所收取的配送费和仓库保管费进行统计。 

实验项目 9：客户管理系统的运用 

1、 教学内容 

客户管理中心是查询、删除、新增客户、赋予每个客户唯一的识别号；输入、修改客户资料，包括

客户背景、联系人、客户业务范围、与本公司相关的业务范围等详细内容；查看客户联系信息，查看客

户服务信息。 

2、教学目标 

（1）掌握代理客户统计与查询和配送客户统计； 

（2）掌握输入、修改客户资料，包括客户背景、联系人、客户业务范围、与本公司相关的业务范

围等详细内容。 

三、考核方式及要求 

1、考核方式为考查。 

2、学生实训课程评分方法： 

（1）课堂综合表现，占 30 分，包括课堂中是否认真填写各类练习以及是否积极参与讨论、积极发
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表意见、回答讲师提问等方面； 

（2）课后实验报告，占 40 分，要求 3000 字左右，根据综合演练的情况完成实习报告； 

（3）实战操作成绩，占 30 分，根据每个学生的实际操作成绩打分。 

四、主要仪器设备及实验材料 

项目编号 实验项目名称 
主要仪器设备 

及台（套）数 
实验材料 备注 

1212020260101 交易中心注册 
电脑（60 台）、

软件、投影 
  

1212020260102 认证中心信息完善 
电脑（60 台）、

软件、投影 
  

1212020260103 调度中心管理 
电脑（60 台）、

软件、投影 
  

1212020260104 仓储中心管理 
电脑（60 台）、

软件、投影 
  

1212020260105 运输中心操作 
电脑（60 台）、

软件、投影 
  

1212020260106 货托中心业务处理 
电脑（60 台）、

软件、投影 
  

1212020260107 结算中心数据处理 
电脑（60 台）、

软件、投影 
  

1212020260108 财务统计业务操作 
电脑（60 台）、

软件、投影 
  

1212020260109 客户管理系统运用 
电脑（60 台）、 

软件、投影 
  

五、教材及参考书 

1、…； 

2、…； 

…书名.著者.版本.出版社.出版日期 

六、教改说明及其他 

实验所用软件：南京商友教学软件有限公司研发的企业供应链动态教学系统。 

大纲制定人：  郭瑞  

大纲审定人：   
何 叶 荣  

制 定 时 间：  
20 1 6 年 5 月  

 



 
 

  53

网上开店实验课程教学大纲 

课程编号：12120202602                       课程属性： 必修     

实验学时： 36                       实验个数：10   

学    分：2                        开课学期：5      

适用专业： 市场营销           

课程简介：    网上开店是市场营销专业的实验必修课。通过本课程的学习，熟悉并掌

握网上开店的整个流程，了解商品体系划分，在电子商务平台上开店并发布产品，利用网

络营销的知识进行网店推广并最终达成产品或销售，并了解客户服务、售后及客户关系管

理的相关知识。 

通过成功与失败的网上创业案例的讨论与分析，增强学生对创业的感性和理性认识；

通过模拟软件实验教学和创业计划书的撰写培养学生创业动作能力。 

本课程的教学方法主要以软件模拟和学生在电子商务平台开店并推广为主，培养学生

的创新创业精神、掌握网店运营的相关知识，增加学生的实际操作能力。 

项目编号 实验项目名称 
实验 

类型 

开出 

要求 

学时 

分配 

每组 

人数 

1212020260201 2015‐2016 互联网发展现状 综合 必修 4  

1212020260202 走进淘宝 综合 必修 4  

1212020260203 网店商品管理 综合 必修 4  

1212020260204 网店推广 综合 必修 6  

1212020260205 速卖通开店 综合 必修 4  

1212020260206 平台规则 综合 必修 2  

1212020260207 市场选品 综合 必修 2  

1212020260208 跨境物流 综合 必修 4  

1212020260209                 数据分析 综合 必修 4  

1212020260210                 跨境支付 综合 必修 2  

学时总计 36 

二、实践内容及教学要求 

实验项目 1：2015-2016 互联网发展现状 

1、教学内容 

让学生了解 2015 年互联网发展现状,尤其是互联网电子商务的发展现状。 

2、教学目标 
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（1）了解电商市场一超多强的现状。  

（2）了解生鲜、海淘和母婴市场发展现状。 

（3）了解团购及外卖市场发展现状。 

实验项目 2：走进淘宝 

1、教学内容 

让学生在现有的电子商务平台中开设网店，了解网店开设流程，在网店及支付系统实名认证的过程

中理解认证的方法和相关的身份认证技术。。 

2、教学目标 

（1）了解网店开设流程  

（2）熟悉网店及支付系统实名认证 

（3）掌握实名认证的方法和相关身份认证技术 

实验项目 3：网店商品管理 

1、教学内容 

了解淘宝卖家后台功能，掌握如何上传产品、管理产品等。 

2、教学目标 

（1）了解卖家中心 

（2）掌握上传产品的技巧和上传产品的时间 

实验项目 4：网店推广 

1、教学内容 

让学生对开设的网络店铺进行装修，针对不同的产品和服务有不同的店铺风格，在美化店铺后，通

过网络对店铺进行推广。 

2、教学目标 

（1）了解店铺风格和装修对顾客购物和转化率的影响  

（2）熟悉 CSS 和 HTML，熟练使用 photoshop 软件 

（3）掌握目前主要的网络推广方法，如搜索引擎营销、关键词营销、事件营销等 

实验项目 5：速卖通开店 

1、教学内容 

让学生了解速卖通，并且掌握如何开店。 

2、教学目标 

（1）了解速卖通 
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（2）熟悉开店流程，并开店。 

 

 

实验项目 6：平台规则 

1、教学内容 

掌握速卖通的平台规则。 

2、教学目标 

（1）发布规则 

（2）交易规则 

（3）放款规则 

（4）评价规则 

实验项目 7：市场选品 

1、教学内容 

如何进行站内和站外选品，选品觉得店铺成败。 

2、教学目标 

（1）掌握站内选品 

（2）了解站外选品 

实验项目 8：跨境物流 

1、教学内容 

掌握跨境物流，合理选择最优方式发货。 

2、教学目标 

      （1）邮政物流介绍 

       （2）商业快递介绍 

       （3）专线物流介绍 

实验项目 9：数据分析 

1、教学内容 

    学会运用卖家后台数据纵横，优化自己的店铺，提升流量，提高订单量。 

2、教学目标 

 （1）行业情报 

  （2）选品专家 
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  （3）搜索词分析 

  （4）店铺经营分析 

实验项目 10：跨境支付     

1、教学内容 

    了解国际支付宝，掌握支付宝收款设置，以及相关费用问题。 

2、教学目标 

  （1）国际支付宝 

   （2）收款账户设置 

三、考核方式与成绩评定 

1、考核方式：实验报告 

2、成绩评定：实验过程表现和考勤占 30%，实验报告 70% 

四、主要仪器设备及实验材料 

项目编号 实验项目名称 
主要仪器设备 

及台（套）数 
实验材料 备注 

1212020160101 2015 互联网发展现状 计算机 111 台和服务器 1 台 实验报告等  

1212020160102 走进淘宝 计算机 111 台和服务器 1 台 实验报告等  

1212020160103 网店商品管理 计算机 111 台和服务器 1 台 实验报告等  

1212020160104 网店推广 计算机 111 台和服务器 1 台 实验报告等  

1212020160105 速卖通开店 计算机 111 台和服务器 1 台 实验报告等  

1212020160106 平台规则 计算机 111 台和服务器 1 台 实验报告等  

1212020160107 市场选品 计算机 111 台和服务器 1 台 实验报告等  

1212020160108 跨境物流  计算机 111 台和服务器 1 台 实验报告等  

1212020160109 数据分析  计算机 111 台和服务器 1 台 实验报告等  

1212020160110 跨境支付  计算机 111 台和服务器 1 台 实验报告等  

五、教材及参考书 

参考书：1、邓顺国.网上创业.北京:高等教育出版社,2008； 

2、王亚利,余伟萍.创业方案及点评.北京:清华大学出版社,2006； 

3、肖龙.网上开店创业指南.北京:中国宇航出版社,2007； 

4、武新华等.网上创业指南(第 2 版).北京:机械工业出版社,2009； 

5、陈飞，彭文芳.  网上开店与创业.北京：清华大学出版社，2009 

六、教改说明及其他 
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大 纲 制 定 人：  聂 梓  

大 纲 审 定 人：   何 叶 荣  

制 定 时 间：  2 0 1 6 年 5 月  
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营销之道实验课程教学大纲 

课程编号：12120202603                              课程属性：实验实训课             

学        时：  38                                              学        分：  2     

开课学期：6                                                  适用专业：市场营销           

先修课程：管理学、市场营销、人力资源管理、市场营销调研、消费者行为

学等           

课程简介：   

《营销之道》是一套营销管理技能的综合训练平台，营销之道通过对企业营销管理的

模拟，将企业运营中普遍应用的营销知识、工具、模型、方法与国内外成功企业的营销管

理经验融入到虚拟企业的经营管理中，使学生在模拟经营中快速掌握营销管理这一实践性

极强的学科知识，并使复杂、抽象、枯燥的营销理论知识趣味化、生动化和形象化。 

《营销之道》模拟实战系统采用国际领先的商业模拟实战训练模式，全程在分组对抗

与模拟实战的形式下学习与训练营销管理技能。参训学生分组组建成相互竞争的团队，每

个团队分别组建一家模拟企业，通过团队的运营管理，运用所学的营销管理知识技能，努

力提升企业绩效，在若干个经营周期内实现企业的经营目标。 

一、实验项目设置及学时分配 

项目编号  实验项目名称 
实验 

类型 

开出 

要求 

学时

分配

121202026030

1 
《营销之道》概述，团队职责分工  综合性  必做  2 

121202026030

2 
熟悉整个系统的操作使用  综合性  必做  4 

121202026030
3  第一季度模拟企业运营管理  综合性  必做  4 

121202026030
4  第二季度模拟企业运营管理  综合性  必做  4 

121202026030
5 

第三季度模拟企业运营管理  综合性  必做  4 

121202026030
6 

第四季度模拟企业运营管理  综合性  必做  4 

121202026030
7  第一阶段模拟运营总结  分析讨论  选做  2 

121202026030
8 

第五季度模拟企业运营管理  综合性  必做  4 

121202026030
9 

第六季度模拟企业运营管理  综合性  必做  4 
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121202026031
0 

第七季度模拟企业运营管理  综合性  必做  2 

121202026031
1 

第八季度模拟企业运营管理  综合性  必做  2 

121202026031
2 

整个实验课程的总结  分析讨论  选做  2 

学时总计  38 

 

二、实验内容及教学要求 

实验项目 1：《营销之道》概述，团队职责分工 

1、 教学内容 

            结合相关理论知识，如管理学、市场营销学、人力资源管理；消费者行为学、市场营销调研等，

为此次模拟实训课程做好必要的准备工作，每个小组成员要熟悉自己的角色。 

2、教学目标 

（1）系统介绍，规则介绍，商业背景环境介绍； 

（2）组建团队，职责分工，命名企业名称，团队述职； 

实验项目 2：熟悉整个系统的操作使用 

1、教学内容 

要对该操作系统模块进行系统的学习和认识，熟悉每个模块的作用和操作原理。 

2、教学目标 

（1）查看系统中的演示数据，分析其他团队的做法； 

（2）模拟运营 1－2 个周期，熟悉所有操作； 

（3）使用中的疑问进行答疑交流。 

实验项目 3：第一季度模拟企业运营管理 

1、 教学内容 

在第一季度，企业刚起步，要充分结合企业此时资金不足，产品缺乏竞争力的特点，充分考虑企业

的组织架构，完成第一季度模拟企业运营管理。 

2、教学目标 

（1）知识讲解：认识企业，组织架构与分工； 

（2）模拟实训：第一季运营管理； 

（3）小组讨论：第一季运营绩效； 

（4）互动点评：第一季运营得失。 

实验项目 4：第二季度模拟企业运营管理 

1、 教学内容 

结合企业第一季度的成败，做好 SWOT 细分工作，在市场细分的基础上选择合适的目标市场，完

成第二季度模拟企业运营管理。 

2、教学目标 

（1）知识讲解：SWOT 分析，市场细分，目标市场选择； 

（2）模拟实训：第二季运营管理； 

（3）小组讨论：第二季运营绩效； 

（4）互动点评：第二季运营得失。 
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实验项目 5：第三季度模拟企业运营管理 

1、教学内容 

结合企业第二季度的成败，充分发挥营销策略组合的优势，完成第三季度模拟企业运营管理。 

2、教学目标 

（1）知识讲解：营销策略组合； 

（2）模拟实训：第三季运营管理； 

（3）小组讨论：第三季运营绩效； 

（4）互动点评：第三季运营得失。 

实验项目 6：第四季度模拟企业运营管理 

1、教学内容 

结合企业第三季度的成败，放眼国际商场，做好互联网营销和服务营销工作，完成第四季度模拟

企业运营管理。 

2、教学目标 

(1)知识讲解：国际市场营销，互联网营销，服务营销； 

(2)模拟实训：第四季运营管理； 

(3)小组讨论：第四季运营绩效； 

(4)互动点评：第四季运营得失。 

实验项目 7：第一阶段模拟运营总结 

1、教学内容 

结合前四个季度的成功经验与失败教训，对第一阶段的模拟运营做一个系统的分析讨论会。 

2、教学目标 

（1）各企业总经理述职； 

（2）第一阶段企业经营得失总结； 

（3）小组互评与老师点评。 

实验项目 8：第五季度模拟企业运营管理 

1、教学内容 

认真总结前四个季度的经验得失，展开新一轮的工作安排，认真分析波士顿矩阵，结合产品生命

周期规律，完成第五季度模拟企业运营管理。 

2、教学目标 

（1）知识讲解：波士顿矩阵分析，产品生命周期； 

（2）模拟实训：第五季运营管理； 

（3）小组讨论：第五季运营绩效； 

（4）互动点评：第五季运营得失。 

实验项目 9：第六季度模拟企业运营管理 

1、 教学内容 

该季度要重视品牌策略，努力为企业打造成功品牌，完成第六季度模拟企业运营管理。 

2、教学目标 

（1）知识讲解：品牌策略； 

（2）模拟实训：第六季运营管理； 

（3）小组讨论：第六季运营绩效； 
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（4）互动点评：第六季运营得失。 

实验项目 10：第七季度模拟企业运营管理 

2、 教学内容 

结合企业第六季度的成败，在财务分析的基础上，全面做好预算管理工作，完成第二季度模拟企业

运营管理。 

2、教学目标 

（1）知识讲解：全面预算管理，财务分析； 

（2）模拟实训：第七季运营管理； 

（3）小组讨论：第七季运营绩效； 

（4）互动点评：第七季运营得失。 

实验项目 11：第八季度模拟企业运营管理 

1、教学内容 

结合企业第七季度的成败，加强团队的沟通协作，授权合理，提高决策部门的执行力，完成第八

季度模拟企业运营管理。 

2、教学目标 

（1）知识讲解：团队沟通与协作，授权，执行力； 

（2）模拟实训：第八季运营管理； 

（3）小组讨论：第八季运营绩效； 

（4）互动点评：第八季运营得失。 

实验项目 12：整个实验课程的总结 

1、教学内容 

结合前八个季度的成败得失，最整个模拟过程开展一次全面系统的讨论会，为日后的实践工作打好

坚实的基础。 

2、教学目标 

(1)小组总结：自评与互评整个实训过程的得失情况； 

(2)教师总结：最终小组经营成绩及各组综合表现； 

(3)课程总结：对理论与实践结合应用的总结。 

 

 

三、考核方式及要求 

1、考核方式为考查。 

2、学生实训课程评分方法： 

（1）课堂综合表现，占 30 分，包括课堂中是否认真填写各类练习以及是否积极参与讨论、积极发

表意见、回答讲师提问等方面； 

（2）课后实验报告，占 40 分，要求 3000 字左右，根据综合演练的情况完成实习报告； 

（3）实战经营绩效，占 30 分，根据所在小组的综合成绩排名情况打分。 
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四、主要仪器设备及实验材料 

项目编号 实验项目名称 
主要仪器设备 

及台（套）数 
实验材料 备注

1212020260301 《营销之道》概述，团队职责分工
电脑（60 台）、

软件、投影 
 

1212020260302 熟悉整个系统的操作使用 
电脑（60 台）、

软件、投影 
  

1212020260303 第一季度模拟企业运营管理 
电脑（60 台）、

软件、投影 
  

1212020260304 第二季度模拟企业运营管理 
电脑（60 台）、

软件、投影 
  

1212020260305 第三季度模拟企业运营管理 
电脑（60 台）、

软件、投影 
  

1212020260306 第四季度模拟企业运营管理 
电脑（60 台）、

软件、投影 
  

1212020260307 第一阶段模拟运营总结 
电脑（60 台）、

软件、投影 
  

1212020260308 第五季度模拟企业运营管理 
电脑（60 台）、

软件、投影 
  

1212020260309 第六季度模拟企业运营管理 
电脑（60 台）、

软件、投影 
  

1212020260310 第七季度模拟企业运营管理 
电脑（60 台）、

软件、投影 
  

1212020260311 第八季度模拟企业运营管理 
电脑（60 台）、

软件、投影 
  

1212020260312 整个实验课程的总结 
电脑（60 台）、

软件、投影 
  

五、教材及参考书 

        自编讲义 

六、教改说明及其他 

实验所用软件：杭州贝腾科技有限公司研发的《营销之道》软件 

 

 

大 纲 制 定 人：  旻陈 方  

大 纲 审 定 人：   何 叶 荣  

制 定 时 间：  2 0 1 6 年 5 月  
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推广与策划实践教学大纲 

课程编号：12120202604                        课程属性： 必修     

实验学时： 36                                实验个数：14    

学    分：2                                  开课学期： 6      

适用专业： 市场营销           

课程简介：         

本课程是市场营销等专业的一门专业主干课程，也是其他经济管理类专业不可或缺的

一门重要专业课。这门基于哲学、数学、经济学、管理学、行为科学之上的学科，不仅是

当代企业在迅速变化的市场环境和日趋激烈的竞争中求生存、求发展的管理利器，在社会

经济生活各个方面得到广泛应用。正因为如此，随着现代市场营销实践的蓬勃发展，营销

策划推广已逐渐发展成为该学科一个新的专业发展方向，对营销管理类专业学生来讲，该

课程也成为专业的一门必不可少的核心课程。  

课程定位  ：本课程是高校市场营销专业学生的专业必修课，目的是培养学生运用所

学市场开发与营销专业知识和市场营销策划理论，掌握营销推广与策划的流程。使学生认

识到市场营销策划是建立在市场调研，通过对企业内外部环境分析和企业自身的资源条件

基础上，并具有创新性、可操作性、系统性、实效性、效益性等特点。 

教学方法：推广与策划课程设置的主要目标是培养学生学以致用的策划推广能力，这

种能力是综合性、复合性和系统性的。在课程学习过程中就必须掌握的，是创意形成技能、

信息处理技能和方案表达技能这三种技能，因此在教学过程中，应以此三种技能的培养为

中心，以行业仿真项目推广与策划为基础，营造开放性教学环境，设置更多的学生实践环

节。 

知识体系:本课程是市场营销专业学生的必修课程，实践性较强。主要内容包括：营销

策划的概述、企业市场调研策划、市场定位策划、市场竞争策划、企业形象推广与策划、

产品推广与策划、价格策划、促销推广与策划以及三个具体行业的策划详述。通过营销推

广与策划实训加深对营销策划的基本理论、基本方法的掌握与运用，提高学生分析问题和

解决问题的实践能力，为学生从事营销工作打下基础。 

一、实验项目设置及学时分配 

项目编号 实验项目名称 
实验 

类型 

开出 

要求 

学时 

分配 

每组 

人数 

1212020260401 认识市场营销策划 演示 必修 2  

1212020260402 营销策划的内涵与流程 演示 必修 4  

1212020260403 营销策划的组织与管理 演示 必修 2  
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1212020260404 营销调研策划 综合 必修 2  

1212020260405 企业战略策划 综合 必修 2  

1212020260406 市场营销战略策划 综合 必修 2  

1212020260407 产品策划 综合 必修 2  

1212020260408 定价策划 综合 必修 2  

1212020260409 分销渠道策划 综合 必修 2  

1212020260410 促销策划 综合 必修 2  

1212020260411 房地产市场营销策划 综合 必修 4  

1212020260412 医药保健品营销策划 综合 必修 4  

1212020260413 快速消费品策划 综合 必修 4  

1212020260414 创业项目推广与策划 综合 必修 2  

学时总计 36 

二、实践内容及教学要求 

实验项目 1 认识市场营销策划 

教学目标：了解策划、市场营销策划概念和基本理论，理解市场营销策划的学科特点和研究对

象，了解现代营销观念与营销过程。 

教学内容：第一节 市场营销理论与市场营销策划 

第二节 市场营销策划创意与内容体系 

 

实验项目 2营销策划的内涵与流程 

教学目标：了解市场营销策划方案重要性、作用；理解并掌握市场营销策划方案的流程。 

教学内容：第一节 策划与营销策划 

第二节 营销策划的原理与流程 

第三节 营销策划的认识误区和影响因素 

讨论策划案例与文案：永琪 6 元营销模式 

演示相关链接：关于营销策划的两个软件介绍 

 

实验项目 3 营销策划的组织与管理 

教学目标：理解企业战略组织架构和内容，了解企业管理的基本任务，掌握营销策划的实施步

骤及流程，营销策划评估的方法及改进的策略。 

教学内容：第一节  营销策划的组织 

第二节 营销策划的营销 

第三节 营销策划的实施 

第四节 营销策划的控制 

第五节 营销策划的评估 

 案例分析：格力空调的营销策划实施 
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实验项目 4 营销调研策划 

教学目标：了解市场营销策划方案的概念、影响因素、实施模式、实施程序；理解市场营销调

研策划方案的控制意义、要求、步骤、方法，掌握不同市场环境下调研的特点和作

用。 

教学内容：第一节 营销调研程序 

第二节 宏观环境调研 

第三节 行业环境调研 

第四节 消费者市场调研 

实验项目 5 企业战略策划 

教学目标：理解企业战略的概念和内容，企业整体战略策划的重要性和特征，了解企业基本任

务，确定企业目标的方法；掌握企业业务组合评价方法，企业新业务发展战略。 

教学内容：第一节  企业整体战略策划 

第二节 业务战略策划 

实验项目 6市场营销战略策划 

教学目标：理解市场营销战略的概念和内容，了解市场营销战略的特点，掌握市场营销战略策

划的类型、目标市场战略策划的制定方法。 

教学内容：第一节 市场机会研究 

第二节 目标市场策划 

第三节 企业竞争定位 

第四节 市场竞争战略 

实验项目 7 产品策划 

教学目标：了解产品策划、新产品、产品组合、商标、包装等概念，了解新产品策划书的内容

和样本，掌握产品组合策划的内容和方法，理解商标策划以及包装策划的概念和内

容，了解产品生命周期理论；掌握新产品定位的理论和方法。 

教学内容：第一节 产品定位策划 

第二节 新产品开发策划 

第三节 产品生命周期与营销策划 

第四节 产品组合策划 

第五节 品牌和名牌的营销策划 

第六节 产品包装与服务策划 

案例讨论：农夫山泉、恒大冰泉、依云矿泉水的产品策划 

实验项目 8 定价策划 

教学目标：了解价格策划的概念、目的；掌握新产品和传统产品价格策划的方法，理解企业产

品价格体系的策划；掌握产品定价和调整的方法和策略。 

教学内容：第一节 定价目标策划 

第二节 定价方法和技巧策划 

第三节 价格调整策划 

讨论：商超快销产品的定价策划 
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实验项目 9 分销渠道策划 

教学目标：理解营销渠道、营销渠道策划、营销渠道的长度与宽度概念；掌握渠道策划的六个

C, 渠道长度与宽度的策划，中间商类型的策划。 

教学内容：第一节 分销渠道的作用和分类 

第二节 分销渠道策划 

第三节 渠道建设策划 

第四节 零售商策划 

实验项目 10 促销策划 

教学目标：熟悉促销活动策划的程序；了解促销活动策划的必要性；掌握促销策略组合的设计

方法；掌握促销策划案设计的具体内容和格式要求。 

教学内容：第一节 促销组合 

第二节 促销策略与技巧策划 

第三节 广告促销策划 

第四节 公共关系策划 

第五节 人员销售策划 

实验项目 11 房地产市场营销策划 

教学目标：了解房地产商品的特殊性、房地产市场及其特征；掌握房地产市场营销的特性、房

地产营销策划模式；了解和掌握房地产形象品牌策划、房地产广告促销策划的特点

和方法。 

教学内容：第一节 房地产商品和房地产市场的特点 

第二节 房地产市场营销的方式 

第三节 房地产营销策划 

策划案例与文案：某房地产项目媒体整合推广策划方案 

相关链接：房地产营销的“县域”战术 

策划实战 

实验项目 12 医药保健品营销策划 

教学目标：了解医疗保健品市场及其特征；掌握相关产品市场营销的特性、营销策划模式；了解

和掌握医药保健品渠道选择及广告促销策划的特点和方法。 

教学内容：第一节 医药保健品营销渠道与终端策划 

第二节 医药保健品促销策划 

第三节 医药保健品广告策划 

策划案例与文案：21 金维他：4 年，8000 万元到 10 亿元的崛起之路 

策划实战 

实验项目 13 快速消费品策划 

教学目标：了解快消行业的产品特点；掌握快消产品策划的要点；了解多样的策划方式与创意。 

教学内容：第一节 速消费品概述 

第二节 快速消费品产品策划 

第三节 快速消费品价格策划 

第四节 快速消费品渠道策划 

第五节 快速消费品促销策划 
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策划案例与文案：旁氏化妆品营销策划 

实验项目 14 创业项目推广与策略 

教学目标： 掌握创业项目策划书的撰写格式和内容要求；掌握规范格式创业项目演示文档制作

的方法。 

通过本课程的学习，使学生掌握创业项目策划书的格式与内容，具备方案的阐述能力与答辩能力，

能够根据市场实际对方案进行论证与分析。 

三、考核方式与成绩评定 

1、考核方式 考查 

2、成绩评定 平时成绩占 30％，中期市场营销策划方案（小组）占 30％（自选题目），学期末市场

营销策划及推广方案（个人）占 30%（教师命题）。 平时成绩包括出勤、听课情况、作业完成情况等。 

四、主要仪器设备及实验材料 

项目编号 实验项目名称 
实验 

类型 

开出 

要求 

学时 

分配 

1212020260401 认识市场营销策划 演示 必修 2 

1212020260402 营销策划的内涵与流程 演示 必修 4 

1212020260403 营销策划的组织与管理 演示 必修 2 

1212020260404 营销调研策划 综合 必修 2 

1212020260405 企业战略策划 综合 必修 2 

1212020260406 市场营销战略策划 综合 必修 2 

1212020260407 产品策划 综合 必修 2 

1212020260408 定价策划 综合 必修 2 

1212020260409 分销渠道策划 综合 必修 2 

1212020260410 促销策划 综合 必修 2 

1212020260411 房地产市场营销策划 综合 必修 4 

1212020260412 医药保健品营销策划 综合 必修 4 

1212020260413 快速消费品策划 综合 必修 4 

1212020260414 创业项目推广与策划 综合 必修 2 

学时总计 36 

五、教材及参考书 

教  材：《营销策划：方法、技巧与文案》（第 2 版），孟韬 毕克贵 编著，机械工业出版社，2012 

参考书： 

1、《营销策划》(第 1 版)，张科平编，清华大学出版社，2007 年 4 月； 

2、《营销策划》(第 2 版)，叶万春、叶敏编著，清华大学出版社，2008 年； 

3、《营销管理》(第 14 版)，菲利普•科特勒主编，格致出版社，2012 年 8 月；  

4、《网络营销与策划》(第 1 版)，刘芸编，清华大学出版社，2010 年 8 月； 
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5、《网络营销推广》(第 1 版)，江礼坤主编，电子工业出版社，2012 年 1 月； 

6、《营销策划技术》(第 1 版)，梁慧琼主编，人民邮电出版社， 2011 年 5 月； 

7、《促销管理技术实训》（第 1 版），李纲、程鹏主编，机械工业出版社，2008 年 10 月； 

8、《市场调研与预测》（第 3 版），陈启杰主编，上海财经大学出版社，2008 年 12 月。 

9、《企业形象策划实务》  周朝霞主编  机械工业出版社 2014.10 

10、《市场营销经典案例与解读》 胡德华编著  电子工业出版社 2013.6 

六、教改说明及其他 

大 纲 制 定 人：  聂 梓  

大 纲 审 定 人：   何 叶 荣  

制 定 时 间：  2 0 1 6 年 5 月  

（此处加盖院系公章）             
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ERP 经营沙盘模拟实验课程教学大纲 

课程编号： 12120202604                课程属性：实验实训课     

实验学时： 36 学时                     实验个数：5 

学    分： 2 学分                     开课学期： 第 6 学期                      

适用专业： 市场营销       

课程简介： 

ERP 经营沙盘模拟实训课程是集知识性、趣味性、对抗性于一体的企业管理技能训练课程。通过直

观的企业沙盘，模拟企业实际运行状况，内容涉及企业整体战略、产品研发、生产、市场、销售、财务

管理、团队协作等多个方面，让学生在游戏般的训练中体验完整的企业经营过程，感受企业发展的典型

历程，感悟正确的经营思路和管理理念。该课程可以强化学生的管理知识、训练管理技能，全面提高学

生的综合素质。 

ERP 经营沙盘模拟实训课程的基础背景设定为一家已经经营若干年的生产型企业，此课程将把学生

分成 7-8 组，每组 5-6 人，每组各代表不同的一个虚拟公司，在这个训练中，每个小组的成员将分别担

任公司中的重要职位（CEO、CFO、市场总监、生产总监等）。学生在实践模拟对抗中分析规律，制定策

略，模拟全面预算管理。 

ERP 经营沙盘模拟实训课程属于会计学、财务管理、市场营销等专业的实验实训课程。 

一、实验项目设置及学时分配 

项目编号 实验项目名称 
实验 

类型 

开出 

要求 

学时 

分配 

12120203k60501 手工沙盘演示   演示 选做 4 

12120203k60502 电子沙盘软件基本操作 验证 必做 8 

12120203k60503 分阶段实现电子沙盘软件模拟企业经营 设计 必做 12 

12120203k60504 综合运用电子沙盘软件模拟经营对抗 综合 必做 8 

12120203k60505 经营结果分析  综合 必做 4 

学时总计 36 

二、实验内容及教学要求 

实验项目 1：手工沙盘演示 

1、教学内容提要 

（1）手工沙盘盘面和沙盘语言介绍； 

（2）手工沙盘上各个角色定位。 

2、教学目标要求 

（1）了解手工沙盘的盘面； 

（2）熟悉和掌握手工沙盘上沙盘语言和角色分工定位。 

实验项目 2：电子沙盘软件基本操作 
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1、教学内容提要 

  （1）电子沙盘界面标识和基本软件操作； 

  （2）电子沙盘的运营规则。 

2、教学目标要求 

  （1）了解电子沙盘的界面标识； 

  （2）熟悉产品销售，区域市场渠道建设、资金运营等运营规则； 

  （3）掌握电子沙盘软件的原理和基本操作方法。 

实验项目 3：分阶段实现电子沙盘软件模拟企业经营 

1、教学内容提要 

  （1）电子沙盘操作； 

  （2）分阶段模拟企业经营运营。 

2、教学目标要求 

 （1）熟悉模拟企业的经营运营规则； 

     （2）学生按照角色要求，掌握模拟企业流程运行任务的年初任务、流程运行任务的季度任流程运

行任务的年末任务和流程运行任务的特殊运行任务。 

实验项目 4：综合运用电子沙盘软件模拟经营对抗 

1、教学内容提要 

（1）电子沙盘操作； 

（2）综合模拟企业经营运营。 

2、教学目标要求 

（1）掌握模拟企业的经营运营规则； 

  （2）学生按照角色要求，综合掌握电子沙盘软件中厂房的购买、出售和租赁；生产线的购买、转

产与维修、出售；原材料采购；产品研发和国际认证；产品生产；融资贷款和贴现等若干操作。学生掌

握在模拟企业的各个经营决策中各自的角色并能很好的运用。 

实验项目 5：经营结果分析 

1、教学内容提要 

  财务数据分析和经验总结。 

2、教学目标要求 

  通过分析系统中导出的财务数据分析各队的经营成果，并对此进行点评总结经验，使学生理解经

营对抗的取胜之道。 

三、考核方式及要求 

1、考核方式为无纸化考试，根据学生出勤率、在实验课程中的表现以及实验作业三个方面给出实

验成绩。 

2、成绩评定 

（1）优秀：遵守实验室制度，按时到达实验地点，表现认真积极；上机表现好，无打游戏和聊天情

况，纪律严明，实习态度认真，布置的上机作业完成效果好；实训报告能对实训内容进行全面、系统的

总结，并能运用理论知识及时处理实训时遇到的问题。 

（2）良好：遵守实验室制度，按时到达实验地点，表现认真；上机表现好，纪律严明，实习态度认

真，布置的模拟作业完成较好，实训报告能对实训内容进行较全面、系统的总结。 

（3）中等：遵守实验室制度，按时到达实验地点，表现一般；纪律较好，实习态度较认真，布置的
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模拟作业按时完成，实训报告能对实训内容进行比较全面的总结。 

（4）及格：有少量迟到现象，但整体表现还可以；纪律较好，实习态度较认真，布置的模拟作业基

本，能够完成实训报告，内容基本正确、系统。上机有打游戏和聊天现象，但经教育改正者。 

（5）不及格：旷课现象严重；实验作业拖交、缺交；上机时打游戏、聊天或干与本课程无关的事，

经教育不改者。 

四、主要仪器设备及实验材料 

项目编号 实验项目名称 
主要仪器设备 

及台（套）数 
实验材料 备注 

12120203k60501 手工沙盘演示 
物理沙盘、计算机软硬

件、投影仪 
  

12120203k60502 电子沙盘软件基本操作 计算机软硬件、投影仪   

12120203k60503 
分阶段实现电子沙盘软件

模拟企业经营 
计算机软硬件、投影仪   

12120203k60504 
综合运用电子沙盘软件模

拟经营对抗 
计算机软硬件、投影仪   

12120203k60505 经营结果分析 计算机软硬件、投影仪   

五、教材及参考书 

教  材：《创业者沙盘实训教程——财务管理综合实验用书》，徐利飞编著，东北财经大学出版社，

2015 年 

参考书： 

1.《创业者电子沙盘实训手册——企业经营沙盘模拟实战对抗》，刘平编著，清华大学出版社，2011 

2．《ERP 商业沙盘实训教程》，徐建华编著，西南交通大学出版社，2011 

3．《ERP 沙盘模拟学习指导书》，王新玲、柯明、耿锡润编著，中国矿业大学出版社，2006  

4．《企业经营竞争模拟实验教程》，李晓安编著，湖北人民出版社，2007 

5．《ERP 沙盘模拟学习指导书》，王亮编著，电子工业出版社， 2009 

六、教改说明及其他 

本课程完全基于网络平台进行操作，对计算机硬件和软件要求较高，由于机房设备老

旧等原因，在日常授课中经常出现卡顿或者直接登录不上系统以及电脑突然关机等现象，

故建议考虑更新一部分老旧的实验设备。 

 

大纲制定人： 郭 瑞  

大纲审定人： 何 叶 荣  

制 定 时 间 ： 2 0 1 6 年 5 月  

 


